IBM StorWatch Serial Storage Expert
User’s Guide
Note

Before using this information and the product it supports, be sure to read the general information under "Notices" on page vii.

Third Edition (May 1999)

This edition applies to Version 1 Release 1 Modification 2; of the IBM StorWatch Serial Storage Expert and to all subsequent releases and modifications until otherwise indicated in new editions.

© Copyright International Business Machines Corporation 1996, 1998, 1999. All rights reserved.

US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
Contents

Summary of Changes .................. v

Notices .............................. vi i
Trademarks............................ ix

About the IBM StorWatch Serial Storage Expert User’s Guide, SC26-7267 ............... xi
Who should read this book .......... xi
AIX commands ......................... xi
On-line help information ............. xi

Chapter 1. IBM StorWatch Serial Storage Expert (StorX)—Introduction 1
Functional overview .................. 2
What is the Planner? ................... 3
Sample Planner management sets .... 3
What is the Live Viewer? .............. 3
What is an SSA storage network? ...... 4
What is a management set? .......... 4
What is on the StorX display? ....... 5
Device icons .......................... 7
If you need help... ................... 7

Chapter 2. Installing and starting the IBM StorWatch Serial Storage Expert 9
Installation requirements .............. 9
Licenses ................................ 9
Installing the IBM StorWatch Serial Storage Expert from the web site ... 9
Installing the IBM StorWatch Serial Storage Expert from the CD-ROM .... 9
Installing the IBM SSA Network Agent for Windows NT 4.0 ............... 10
Using the StorX License Installation Diskette ......... 11
Operating requirements .............. 11
Starting StorX with a program icon ... 12
Starting StorX with a file icon ....... 12
Starting StorX with a command ....... 13

Chapter 3. Working with management sets ................................ 15
Creating a Planner management set ... 15
Specifying defaults for the current management set .................. 15
Specifying defaults for new management sets ......................... 15
Naming a management set ............. 15
Opening a management set ........... 16
Creating a Live Viewer management set ......................... 16
Specifying the domain for a management set ....................... 16
Setting the polling time interval .... 18
What is the Event Monitor? ......... 18
  Selecting all event log entries ...... 19
Copying event log entries to the clipboard ........ 19
Exporting Event Log entries ......... 19
Finding a device associated with an event ........ 19
Clearing event log entries .......... 20
What are the device states? ........... 20
Displaying statistics about a management set ........ 21
Identifying missing connections ........ 22
Clearing changes in a management set .... 22
Deleting missing devices in a management set .... 22
Discovering a storage network ....... 22
Starting and stopping automatic refresh ... 23
Refreshing a storage network .......... 23
Performing a full refresh of a storage network ........ 23
Performing a topology refresh of a storage network ........ 23
Deleting objects in a management set ...... 23
Viewing a large management set ....... 24
Working with the Storage Network Navigator 24
  Showing or hiding a storage network .... 26
  Deleting a storage network ........ 26
  Highlighting a storage network .... 26
  Displaying the state of a storage network ... 27
Renaming a storage network ......... 27
Exporting a management set .......... 27
Merging management sets .......... 27
Saving a management set ........... 28
Copying a management set .......... 28
Closing a management set ........... 29
Exiting StorX ........................ 29

Chapter 4. Using event forwarding .... 31
What is SNMP? ......................... 31
SNMP MIB variables and events ...... 31
Starting or stopping event forwarding .... 33

Chapter 5. Working with hosts ....... 35
Adding a host to a management set .... 35
Deleting a host from a management set .......... 35
Displaying the host operating system .... 36
Displaying the state of a host .......... 36
Displaying the version date of the SSA network agent on a host .......... 36
Finding adapters installed on a host .... 37
Displaying logical disk information for a host .... 37

Chapter 6. Working with devices ....... 39
Determining the devices StorX supports .... 39
Specifying the default adapters for a Planner management set ........ 39
Adding an adapter to a Planner management set ....... 39
Specifying the default disks for a Planner management set ........ 39
Adding a disk to a Planner management set ........ 40
Specifying the default connections for a Planner management set ....... 40

© Copyright IBM Corp. 1996, 1998, 1999
Summary of Changes

This section summarizes changes made to the IBM StorWatch Serial Storage Expert product and this publication.

Support for two types of discover operations
StorX now supports a full discover operation and a topology discover operation. See "Performing a full refresh of a storage network" on page 23 and "Performing a topology refresh of a storage network" on page 23 for additional information.

SNMP event forwarding
StorX now supports SNMP event forwarding. See "Chapter 4. Using event forwarding" on page 31 for additional information.

Automatic refresh discover of storage networks
When SNMP event forwarding is enabled, StorX automatically initiates a discover operation when an event occurs.

Selecting defaults from the parts palette
You can now select defaults for adapters, disks, enclosures, connections, and box colors from the parts palette. Previously, you had to access a Management Set Properties window.

Deletion of devices when an enclosure is deleted.
StorX now deletes the devices in an enclosure when you delete the enclosure if you are using the Planner. If you are using the Live Viewer StorX checks the status of the devices before deleting. See "Deleting an enclosure" on page 43 for additional information.

Removal of midpoint connections
You can select to have StorX remove the midpoint connections between devices on the graphical display of your storage network. See "Deleting connection midpoints" on page 41 for additional information.
This information was developed for products and services offered in the U.S.A. IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
500 Columbus Avenue
Thornwood, NY 10594
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

© Copyright IBM Corp. 1996, 1998, 1999
IBM Corporation
Software Interoperability Coordinator
3605 Highway 52 N
Rochester, MN 55901-7829
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this information and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement, or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurement may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to change before the products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrates programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. You may copy, modify, and distribute these sample programs in any form without payment to IBM for the purposes of developing, using, marketing, or distributing application programs conforming to IBM’s application programming interfaces.
Trademarks

The following terms are trademarks of the IBM Corporation in the United States or other countries or both:

AIX
IBM
IBM StorWatch Serial Storage Expert
Pentium
RS/6000
StorX

Microsoft, Windows, Windows NT, Windows 95, and Windows 98 are trademarks or registered trademarks of Microsoft Corporation.

UNIX is a registered trademark in the United States and other countries licensed exclusively through X/Open Company Limited.

Avery is a trademark of the Avery Dennison Corporation.

Pentium is a trademark or registered trademark of Intel Corporation.

Other company, product, and service names, which may be denoted by a double asterisk (**), may be trademarks or service marks of others.
About the IBM StorWatch Serial Storage Expert User’s Guide, SC26-7267

This book explains how to install, manage, and use the IBM StorWatch Serial Storage Expert (StorX) product.

Who should read this book

This book is intended for storage network administrators who are familiar with Serial Storage Architecture (SSA) and general storage network concepts.

AIX commands

AIX commands are represented in lowercase and bold typeface, for example, `cfgmgr`.

When you want to run an AIX command, you can usually enter the `smit` command followed by the command name, `(smit <command name>)` to access a display that prompts you for the required parameters.

On-line help information

The IBM StorWatch Serial Storage Expert contains extensive on-line help information describing the functions of StorX and many of the tasks you will want to perform. You can access the on-line help information by clicking the Help icon on the toolbar or clicking Help on the Menu Bar.
Chapter 1. IBM StorWatch Serial Storage Expert (StorX)—Introduction

The IBM StorWatch Serial Storage Expert (StorX) is a graphical tool for managing Serial Storage Architecture (SSA) storage networks. StorX functions with the family of SSA adapters, SSA disk units, and SSA enclosures that are developed by the IBM Storage System Division. StorX provides:

- A Windows 95, Windows 98, or Windows NT 4.0 graphical user interface. This interface enables you to plan new SSA storage networks, create plans from existing SSA storage networks, or monitor existing SSA storage networks.
- Discovery and display of the SSA topology, capacity, and availability of SSA storage resources.
- Monitoring SSA storage networks for adapter errors and disk errors, topology changes, and Redundant Array of Independent Disks (RAID) events.
- A physical view of disk storage in an SSA storage network.
- Support for SSA enclosures (7133, 7131, and 3527).
- Support for SSA internal backplanes.
- Discovery and display of SSA SCSI Enclosure Services (SES) enclosures.
- The ability to simplify the graphical presentation of your SSA storage networks by collapsing storage networks into a single storage network icon.
- Support for SSA adapters and disks that are attached to RS/6000 servers and SP2 systems that are running AIX.
- Support for SSA adapters and disks that are attached to Intel platform servers that are running Windows NT 4.0.
- The ability to extract and plan detailed information about the SSA devices in your storage networks through a report function.
- The ability to export information to a database or a spread sheet.
- The ability to export a graphical view of a management set, in a BMP or GIF format, for use in a graphic program or web page.
- The ability to automatically locate an SSA device associated with an event that has occurred in your storage network.
- The ability to print cable labels.

You can use the StorX Planner to visually plan your SSA storage network. StorX provides an SSA parts palette for you to add or remove adapters, disks, connections, enclosures, and text and box annotations. Editing tools enable you to select, move and change attributes for any devices in the storage network configuration you are planning.

You can use the StorX Live Viewer to discover SSA storage networks on AIX or Windows NT 4.0 hosts. StorX automatically discovers topology and attributes and displays them on any network-attached PC that is running Windows 95, Windows 98, or Windows NT 4.0. Monitoring for SSA events allows StorX to report adapter errors, disk errors, topology changes, and RAID events.
**Functional overview**

When you are using the Live Viewer, the IBM StorWatch Serial Storage Expert uses a:

- Manager that is installed on a Windows 95, Windows 98, or Windows NT 4.0 system. The manager contains the interface that displays the graphical information that represents the SSA storage networks.
- SSA network agent that is installed on each AIX or Windows NT 4.0 system, that contains SSA adapters in the SSA storage network.
- TCP/IP protocol to communicate between the SSA network agent and the StorX manager.

The manager polls the SSA network agent to gather information about the storage network. The SSA network agent receives the manager’s polling request and reports the status of the devices in the storage network.

The StorX manager uses a Remote Procedure Call (RPC) over a TCP/IP communications network to communicate with the network agent on the host system. Because of this, RPC and TCP/IP must be enabled and active when you are using the IBM StorWatch Serial Storage Expert.

The following diagram shows a conceptual view of the StorX manager and the SSA network agents on the host systems.

*Figure 1. IBM StorWatch Serial Storage Expert — Overview*
What is the Planner?

The Planner displays a window that you can use to plan your storage network by adding adapters, disks, connections, enclosures, text annotations, and boxes.

The Planner can read management sets that are created by the Live Viewer and the Planner, but can only create Planner management sets.

A Planner management set has a file extension of .SPS.

Sample Planner management sets

There are several sample Planner management sets that are supplied and installed with StorX. These files are samples of StorX management sets.

What is the Live Viewer?

The Live Viewer displays a canvas that you can use to monitor or discover an existing storage network. You can add text annotations, boxes, and enclosures to any Live Viewer management set.

When you use the Live Viewer, StorX queries local agents that are installed on host systems by using Transmission Control Protocol/Internet Protocol (TCP/IP). The local agents return information that is related to the devices (disk units, cables, adapters) that are attached to the host. StorX then uses this information to create a graphical representation of the storage network which StorX calls a management set.

A Live Viewer management set has a file extension of .SLS.
When StorX displays a Live Viewer management set, there may be graphic symbols that are placed on the device icons on the canvas. These symbols represent the operational state of the devices on the canvas. You can right-click on the device icon and select Properties to view the operational state of a specific device. Refer to "What are the device states?" on page 20 for additional information about device states.

What is an SSA storage network?

An SSA storage network is a configuration of SSA devices (adapters, disks, cables) that enables a host computer system or set of host computer systems to access data.

The SSA connections between its devices determine the boundary of an individual storage network. StorX considers two devices to be in the same storage network if the devices are connected together.

You can use StorX to manage several storage networks by placing them in a StorX management set. StorX determines the topology of a storage network by requesting information from agent programs that are installed on each of the hosts in the host list.

What is a management set?

A management set is the description of all objects (for example, host computers, disk units, cables, adapters, enclosures, and storage networks) known to StorX. There are two types of management sets:

- Planner management sets: You create these with the Planner. You can use these to plan and design the configuration of a new storage network. You can use the
StorX Planner to merge a management set with other existing management sets. You cannot merge any Planner management sets into a Live Viewer management set.

- Live Viewer management sets: StorX dynamically creates these during the discover process. You can use these to determine the topology of a storage network and monitor the states of the devices in the storage network.

What is on the StorX display?

The StorX display contains the following:

Menu Bar

The menu bar is located at the top of the StorX display. The menu bar functions are, File, Edit, View, Management Set, Tools, and Help.

Toolbar

This area is under the menu bar and contains icons that you can click on to access frequently used functions. You can choose to display or hide the toolbar (see “Showing or hiding the Toolbar” on page 53).

You can determine the function of each icon on the toolbar by placing the mouse pointer on the icon. StorX then displays a text box by the icon that describes the function of the icon. The icons on the toolbar are:

- New: Clicking on this icon clears the canvas and opens a new, untitled, Planner or Live Viewer management set. For more information, see “Creating a Planner management set” on page 15 (Planner), or “Creating a Live Viewer management set” on page 16 (Live Viewer).

- Open: Clicking on this icon displays a window to select the location and the name of the management set you want to open. For more information, see “Opening a management set” on page 16.
Save: Clicking on this icon saves the current management set without changing the file name or directory. For more information, see “Saving a management set” on page 28.

Print: Clicking on this icon prints the current management set. For more information, see “Printing the canvas” on page 63.

Delete: If you are using the Planner, clicking on this icon removes an individual object, or group of objects, on the canvas. For more information, see “Deleting objects in a management set” on page 23.

Pan to: Clicking on this icon causes StorX to display the entire management set. For more information, see “Viewing a large management set” on page 24.

Event Monitor: Clicking on this icon, while using the Live Viewer, displays various events that are occurring in the storage network. For more information, see “What is the Event Monitor?” on page 18.

Help: Clicking on this icon displays the on-line help information index. For more information, see “If you need help...” on page 7.

**Parts Palette**

This area contains icons that you can use to plan a storage network, or add boxes, text, or enclosures to a Planner or Live Viewer management set.

The Parts Palette consists of different icons, depending on whether you are using the Planner or Live Viewer. For example, you are able to add adapters, disks, and connections while using the Planner.

Only one Parts Palette icon can be active at any time. You can display or hide the Parts Palette by placing a check mark next to Show Parts Palette on the View menu (see “Showing or hiding the Parts Palette” on page 53).

You can quickly specify the default for items that want in your current management set by using the Parts Palette. To specify the default you want used in your current management set perform the following steps:

1. On the Parts Palette, place the pointer next to the icon to which you want to specify defaults.
2. Click on the arrowhead symbol in the icon, or right click anywhere on the icon, to display the default selections available to you.
3. Select the default for the item you will be adding to your management set.

You can determine the function of each icon by placing the mouse pointer over it and reading the text box that appears by the icon. The selections available from the Parts Palette are:

- **Select**: When this icon is active, you can use the mouse pointer and mouse buttons to work with objects that are already on the canvas.
- **Add Text**: When this icon is active, position the mouse pointer on the canvas and click the left button to add a text entry field. For more information, see “Adding text to the canvas” on page 53.
- **Add Box**: When this icon is active, position the mouse pointer on the canvas and hold down mouse button 1 and draw the box you want to add. For more information, see “Adding a box to the canvas” on page 54.
- **Add Adapter**: When this icon is active, position the mouse pointer on the canvas and click the left button to add an adapter. You can only add an
adapter if you are using the Planner. For more information, see "Adding an adapter to a Planner management set" on page 39.

- Add Disk: When this icon is active, position the mouse pointer on the canvas and click the left button to add a disk. You can only add a disk if you are using the Planner. For more information, see "Adding a disk to a Planner management set" on page 40.

- Make Connection: When this icon is active, position the mouse pointer on the canvas and click the left button to add a connection. You can only add a connection if you are using the Planner. For more information, see "Connecting devices in a Planner management set" on page 40.

- Add Enclosure: When this icon is active, position the mouse pointer on the canvas and click the left button to add an enclosure. For more information, see "Adding an enclosure to a management set" on page 41.

**Canvas**
StorX uses this area to display the various device icons that represent a Planner or Live Viewer management set.

**Information Area**
This area is at the bottom of the display and shows status information and on-line help information for various StorX functions.

---

**Device icons**

StorX uses icons to represent devices in your management set. You can view these device icons, and their descriptions, by:

- In the Help menu on the menu bar:
  1. Select How Do I...
  2. Select Learn about StorX
  3. Select Device icons.

- In the Help index, select the index entry, 'device icons'.

---

**If you need help...**

The IBM StorWatch Serial Storage Expert application contains extensive on-line help information that describes the functions of StorX and many of the tasks you will want to perform. You can access the on-line help information by clicking the Help icon on the toolbar, or selecting the Help item on the menu bar.

If you need help or have any questions regarding the capabilities or use of StorX, you can contact us at the IBM StorWatch Serial Storage Expert web page.

You can use the web page to download a try and buy version of the program, contact customer support, and download program fixes for associated software. The uniform resource locator (URL) address for this web page is: http://www.ibm.com/storage/storwatch/storx
Chapter 2. Installing and starting the IBM StorWatch Serial Storage Expert

This section provides step-by-step instructions for installing StorX.

Installation requirements

To install the IBM StorWatch Serial Storage Expert on a personal computer, you need the following minimum requirements:

- Personal computer with a Pentium 166 MHz processor, or equivalent.
- 24 MB of RAM (64 MB is recommended)
- 25 MB of free disk space
- VGA display (an SVGA display is recommended)
- Microsoft Windows 95, Windows 98, or Windows NT 4.0

Licenses

Ensure that you review and comply with the IBM StorWatch Serial Storage Expert license agreement.

Installing the IBM StorWatch Serial Storage Expert from the web site

Before you install StorX, you should exit all nonessential programs.

To download and install StorX on your system:

1. Access the StorX web site at the following URL:
   http://www.ibm.com/storage/storwatch/storx
2. Ensure that you uninstall any previous versions of StorX before installing this new version. See “Chapter 13. Uninstalling the IBM StorWatch Serial Storage Expert” on page 71.
3. Select the option to download StorX and fill in the resulting form. When you submit the form, the displays you see are dependent on the browser you are using.
4. After you have downloaded the files, click on the Start button, point to Run, and enter the path and file name of the file you have downloaded.
5. After reviewing the license agreement, respond to the displays that StorX presents to complete the installation process.
6. When the installation process completes, StorX prompts you to view the README file. The README file contains last-minute changes that are important. You should view the contents of the README file at this time.
7. You can then access the StorX program icons from the Start Menu.

Installing the IBM StorWatch Serial Storage Expert from the CD-ROM

Before you install StorX, you should exit all nonessential programs.
Following are the main files that you should be aware of on the IBM StorWatch Serial Storage Expert CD-ROM:

- **setup.exe**: This is the installation program for the IBM StorWatch Serial Storage Expert.
- **pubs**
  - **sxusergd.pdf**: This is the PDF version of the IBM StorWatch Serial Storage Expert User’s Guide, SC26-7267. You can view or print this file by using the Adobe Acrobat Reader 3.01 (or higher) program. You can download the Adobe Acrobat Reader program from the following URL: [http://www.adobe.com/reader](http://www.adobe.com/reader)
  - **sxusergd.htm**: This is the HTML version of the IBM StorWatch Serial Storage Expert User’s Guide, SC26-7267.
- **tools**
  - **refreshstorx**: This is a tar file that contains a command that resets the cache data in the SSA network agent on your system. See “Handling SSA topology changes” on page 67 for a description of this command and when you should use it.
- **aixagent**
  - **devices.ssa.network_agent.tar**: This is the network agent software for AIX 4.1.
- **aixagent**
  - **devices.ssa.network_agent.tar**: This is the network agent software for AIX 4.2
- **aixagent**
  - **devices.ssa.network_agent.tar**: This is the network agent software for AIX 4.3.
- **Ntagent**: This is the software for the NT 4.0 agent.

To install the files that are on the IBM StorWatch Serial Storage Expert CD-ROM:

1. Remove any previous versions of the IBM StorWatch Serial Storage Expert from your system. Use the instructions that are described in “Uninstalling the IBM StorWatch Serial Storage Expert” on page 71 to uninstall the program.
2. Insert the IBM StorWatch Serial Storage Expert CD-ROM disc into your CD-ROM drive.
3. In Windows 95, Windows 98, or Windows NT 4.0, choose the Run command from the Start menu.
4. Type x:\setup.exe (where x:\ is the CD-ROM drive), and click OK.
5. The IBM StorWatch Serial Storage Expert installation dialog box appears. Follow the instructions on-screen to progress through the introduction, accept the license agreement, and select where you want the program installed.
6. When the installation is complete, a message appears indicating that the installation was successful.
7. Insert the StorX License Installation Diskette and run the program on the diskette. See “Using the StorX License Installation Diskette” on page 11.

## Installing the IBM SSA Network Agent for Windows NT 4.0

The IBM SSA network agent enables StorX to discover Window NT 4.0 storage networks.

To install the network agent:
1. Download the Windows NT 4.0 SSA network agent file from the StorX website.
2. Click on Start, then select Run.
3. Type \agentinstall.exe (where \ is the drive and directory that contains the SSA agent software you have downloaded).
4. Respond to the prompts that are displayed to you.

---

**Using the StorX License Installation Diskette**

The StorX License Installation Diskette removes the time restriction of the try and buy period from the IBM StorWatch Serial Storage Expert.

To use the StorX License Installation Diskette:
1. Ensure that you have installed the IBM StorWatch Serial Storage Expert on your computer.
2. Insert the License Installation Diskette in drive a:
3. Click on Start, then select Run
4. Type \setup.exe

StorX will prompt you for your license information.

---

**Operating requirements**

To ensure the proper operation of the StorX Live Viewer, you should ensure the following:

- TCP/IP must be active on the system that is running StorX and the system that contains the adapters.
  
  You can ‘ping’ each system to determine if TCP/IP is active on the Windows systems or the AIX system.

- StorX requires SNMP if you will be using the event forwarding function. You must have Simple Network Management Protocol (SNMP) active on the system that is running the StorX manager.

**Note:** We recommend using Windows NT if you will be using SNMP.

- For Windows 95, refer to the Windows 95 Resource Kit (win95rk.hlp) located on your Windows 95 install CD-ROM. The help topic that describes the installation and setup of SNMP is "Using Remote Administration Tools from Other Vendors". The index term to look for this topic is "SNMP Agent".
  
  You can find the System Policy Editor application on the Windows 95 CD-ROM, or on the Microsoft web site.

- For Windows 98, refer to the Windows 98 Resource Kit (win98rk.hlp) located on your Windows 98 install CD-ROM. Installation is covered in the "Installing the SNMP Agent", and setup is covered under the "Configuring the SNMP Agent" topic. The index term to look for these topics is "SNMP Agent".
  
  You can find the System Policy Editor application on the Windows 98 CD-ROM, or on the Microsoft web site.

- You must have one of the following operating systems installed on the host computer that contains the adapters:
  
  - AIX
To determine the level of AIX on the host system, type:

```
oslevel
```

in an AIX typescript window.

- Windows NT 4.0
- You must have the latest level of SSA adapter microcode and disk microcode installed. Contact your service representative to determine if you need to update the microcode.
- Access the AIX Fix Distribution web site, from the StorX web site, to ensure that you have the latest versions of these device drivers. If you do not have the latest versions of these device drivers, download any of the following device drivers that need to be updated. You can search for these device drivers by name or search for the authorized program analysis report (APAR) number. The APAR numbers are, 71759 for AIX 4.1, or APAR number 71809 for AIX 4.2.
  - devices.mca.8f97.com (all AIX 4.1 and 4.2 systems, only MCA-based AIX 4.3 systems).
  - devices.mca.8f97.diag
  - devices.mca.8f97.rte
  - devices_pci.14104500.diag (PCI systems only)
  - devices_pci.14104500.rte (PCI systems only)
  - devices.ssa.IBM_raid.rte
  - devices.ssa.disk.rte
  - devices.ssa.tm.rte (for target mode applications only)
- You must have the devices.ssa.network_agent fileset on your AIX or your NT systems. You can download the filesets that apply to your AIX or your NT systems from the StorX web page. The AIX filesets are installp packages, in tar format.
- Install the installp packages by using smit.

**Note:** You must restart your system after installing these device drivers.

### Starting StorX with a program icon

To start StorX:

1. Click on the Windows 95, Windows 98, or Windows NT 4.0 Start button.
2. Point to Programs.
3. Point to the Serial Storage Expert program group and click on the icon for the Serial Storage Expert Planner or the Serial Storage Expert Live Viewer.

### Starting StorX with a file icon

You can start StorX by clicking on a management set file icon. When you do this, StorX will start the Planner or Live Viewer, depending on the type of file you selected.
You can start StorX by entering commands in an MS-DOS prompt. To start StorX with a command:

1. Ensure that you are in the directory that contains StorX.
2. Enter one of the following commands in an MS-DOS prompt:
   
   ```
   storx /P  (StorX starts the Planner.)
   storx /L  (StorX starts the Live Viewer.)
   storx /F filename  (If you specify a file name, this command starts StorX and loads the specified file.
   StorX starts the Planner or Live Viewer, depending on the file type of the file you entered.)
   ```
Chapter 3. Working with management sets

This section discusses the various tasks that are associated with Planner and Live Viewer management sets.

Creating a Planner management set

To create a management set with the Planner, click on the New icon in the toolbar, or select File, then New. StorX clears the canvas and creates a new untitled management set. You can now add adapters, disks, connections, enclosures, and annotations to the canvas by selecting the appropriate icon in the parts palette.

To add a part, click the device icon in the Parts Palette, move the mouse pointer onto the canvas, and click the left mouse button.

Specifying defaults for the current management set

You can quickly specify the default for items that want in your current management set by using the Parts Palette. To specify the default you want used in your current management set perform the following steps:

1. On the Parts Palette, place the pointer next to the icon to which you want to specify defaults.
2. Click on the arrowhead symbol in the icon, or right click anywhere on the icon, to display the default selections available to you.
3. Select the default for the item you will be adding to your management set.

Specifying defaults for new management sets

To specify the defaults for a new management set:

1. On the menu bar, click on File, then Management Set Properties (New).
2. Select the appropriate device tab on the Management Set Properties (New) window.
3. Select the default item you want to be used in any new management set that you create.

Note: The defaults that you specify for a new management set will not affect the default settings in your current management set.

Naming a management set

You can assign a name, up to 80 characters in length, and a description to your management set.

To name your management set:

1. On the menu bar, click on File, then Management Set Properties (Current).
2. Click on the General tab on the Management Set Properties window.
3. Type a title and a description of the management set in the Title field and the Descriptions field.
Opening a management set

The Live Viewer can only open a management set that was created with the Live Viewer. The Planner can open either Planner or Live Viewer management sets.

If you have an existing management set open, you are reminded to save or discard any changes before closing the management set.

When you use the Planner to open a management set that is created by the Live Viewer, StorX migrates the management set to a Planner management set. When the management set is migrated StorX removes the logical disk information and host-based attributes for the devices in the storage network.

Notes:
1. When you use the Planner to open a Live Viewer management set, the Planner creates a separate management set. The Live Viewer management set is not changed or renamed.
2. If you are migrating a management set from a previous version of StorX, you should open the management set, save it, then reopen it. This will ensure that the management set has been migrated to the new version of StorX.

To open a management set:
1. Click on the Open icon on the toolbar.
2. StorX displays the Open Management Set window so you can select the management set you want to open.
   If you are currently viewing a management set, StorX warns you that StorX will replace the current management set with the management set you are opening. If you click on OK, StorX displays the Open Management Set window so you can select the management set you want to open.
   Note: If you created the management set you are opening with a newer version of StorX, the open operation will fail. StorX will issue a message that states that you should upgrade to a newer version of the program.

Creating a Live Viewer management set

Discovering a storage network is when StorX queries the storage network that is attached to the host that you have specified. StorX then displays a graphical representation of the host and the SSA devices that are attached to it.

Ensure that you enter a complete list of hosts that are connected to each adapter in a storage network. If you do not enter a complete list of hosts you may encounter adapters that do not provide any attributes. After you have supplied a complete list of hosts, you should rediscover the storage network.

When you start a discover, StorX displays a Discover in Progress window. This window displays messages that indicate the progress of the discover process.

You can click on the Cancel button on the Discover in Progress window to stop the discover process.

You can perform two types of discovery operations:
- Full discover operation: StorX gathers and returns all the device attributes from the devices in the storage network. This type of discover operation is the most complete, but it takes more time than the partial discover operation.

- Topology discover operation: StorX gathers a subset of the device attributes from the devices in the storage network. This type of discover operation provides less detailed information than the full discover operation and takes less time.

To discover a storage network:
1. Start the StorX Live Viewer.
2. Click on the New icon in the toolbar. (If you currently have a management set open, StorX closes it.)
3. StorX opens the Management Set Hosts window.
4. Type the fully qualified host name, or the TCP/IP address, of all the hosts you want in the management set in the Add New Host box.
5. Click the Add button. StorX checks to ensure that the host, with the SSA network agent that is installed, exists. StorX then adds the host to the Hosts in the Management Set box. You can repeat this procedure to add more hosts to your management set.
   If you type a host name that StorX cannot find, StorX will ask you if you want to add the missing host. If you add this unknown host, StorX will attempt to discover the host you have specified.
6. When you have added all of the host computers that you want to discover, click OK. StorX then discovers the storage network components that are accessible from the hosts and displays them on the canvas.

   **Note:** The amount of memory StorX uses increases with the number of devices that are in the management set. For example, if you added another host, with several devices, StorX would use more system memory.

---

### Specifying the domain for a management set

When you use the Live Viewer, you can specify the domain in which the hosts in your SSA storage networks reside. If you do not specify a domain for the management set, StorX will assign a default domain.

The Advanced tab of the Management Set Properties window is used to manage the domain list of your management set.

To specify a domain for the current management set:
1. Click on File, then Management Set Properties (Current).
2. Click on the Advanced tab on the Management Set Properties window.
3. Type the domain name in the Domains field and click Add.

If you would like to set the default device properties for any new management sets that you create in the future, see "Specifying defaults for new management sets" on page 13.
Setting the polling time interval

When you use the Live Viewer, you can choose the polling time interval that you want used to determine how often StorX queries the storage networks. Polling is when StorX queries the storage networks in the management set for SSA events. If StorX detects an event, it displays a pop-up message to inform you that an event has occurred.

To select the event polling time interval:
1. Click on File, then Management Set Properties (Current).
2. Click on the Advanced tab on the Management Set Properties window.
3. Select the Polling Time Interval you want in the Event Polling section.

If you would like to set the default device properties for any new management sets that you create in the future, see "Specifying defaults for new management sets" on page 13.

What is the Event Monitor?

When you are using the Live Viewer, the Event Monitor displays a list of event log entries that have occurred while StorX is running. StorX saves, and restores, the event log entries as part of the management set.

When you are discovering a storage network, StorX opens the event monitor so you can view the events related to the discover process.

If the event monitor is not displayed, you can display it by selecting Event Monitor from the Tools menu on the menu bar. You can also click on the Event Monitor icon on the toolbar.

StorX displays an Event Status indicator on the Event Monitor icon to indicate the status of the management set. The Event Status indicator is a symbol that is displayed on the Event Monitor icon on the Toolbar.

If an event has occurred in your storage network, StorX displays a check mark (✔) by the Event Monitor icon on the toolbar.

If StorX displays either of these symbols, you should look at the event monitor log to determine what event has caused this notification to occur.

When you click on the Event Monitor icons to view the Event Monitor log, StorX clears the Event Status indicator from the Event Monitor icon. The Event Status indicator will return whenever another event or error has occurred in the storage network.

You should perform a Refresh Storage Networks operation if an event or error has been logged in the event monitor. This will update the canvas, and any device attributes, with changes that may have occurred.

You can display the Event Monitor by selecting Event Monitor from the Tools menu on the Menu Bar, or by clicking the Event Monitor icon on the Toolbar.
You can also copy, export, or clear the log entries by selecting Actions on the Event Monitor menu bar. You can also use the Event Monitor to find a device, on the canvas, that is associated with a specific event log entry.

**Selecting all event log entries**

To select all of the log entries in the Event Monitor window:
1. Click Actions, on the Event Monitor menu bar.
2. Click on Select All to highlight all of the log entries.

To de-select all of the log entries, click on any log entry in the window.

**Copying event log entries to the clipboard**

You can copy selected event log entries to the system clipboard in text format so you could paste them into a document.

To copy specific log entries to the system clipboard:
1. In the Event Monitor window, highlight the log entries you want to copy to the clipboard by clicking on them. (You can display the Event Monitor window by clicking on the Event Monitor icon on the toolbar.)
2. Click Actions, on the Event Monitor menu bar and click on Copy.

**Exporting Event Log entries**

You can export the entire event log to a file so you can use an editor to work with the event log.

To export the event log into a file:
1. Click Actions, on the Event Monitor menu bar. (You can display the Event Monitor window by clicking on the Event Monitor icon on the toolbar.)
2. Click Export to open a dialog window, and specify the name of the text file in which you want the log entries saved. The file extension of the new file will be .log.

**Finding a device associated with an event**

You can find a device on the canvas that is associated with a specific event in the Event Monitor window. StorX will find and highlight the associated device on the canvas, and position the canvas to the location of the device.

To find a device that is associated with a specific log entry:
1. Click on a log entry in the Event Monitor window. (You can display the Event Monitor window by clicking on the Event Monitor icon on the toolbar.)
2. Click Actions on the Event Monitor menu bar, then click Find.

The Find function is not active:
- If you have selected multiple log entries in the event log.
- If you have not selected any log entries in the event log.
- If there is no device that is associated with the selected event.

Also, StorX will issue a message if you selected:
• A log entry that is associated with a device that is in a hidden network
• A log entry that is associated with a device that no longer exists in the management set.

Clearing event log entries

The event log can contain up to 1,000 entries before StorX starts writing over existing event log entries. Occasionally, you may want to erase all the entries in the event log.

To clear the entries in the event log:
1. Display the Event Monitor window. (You can display the Event Monitor window by clicking on the Event Monitor icon on the toolbar.)
2. Click Actions, on the Event Monitor menu bar and click Clear. StorX will prompt you with the option to continue or cancel this operation.

Note: Selecting this option deletes all event log entries. Ensure that you do not need to refer to these log entries since you cannot undo this action.

What are the device states?

When you are using the Live Viewer, StorX positions icons over the device icons to indicate the state of a particular device. The device state icons and their meaning are:

Attention
This icon is a circle that is divided into yellow and green halves. The Attention state is not a failure condition, but is a condition of which you should be aware.

For example, a discovered (SES) enclosure can issue an Attention because all slots, in the enclosure, do not contain disks or blanks. This may indicate a problem, such as a drive that is not seated properly in the enclosure. This condition could lead to air flow problems in the enclosure and the devices may not be adequately cooled.

See the appropriate device manual for other conditions that could create an Attention state.

Broken
This icon is a red circle with a jagged line through it. The device has reported a failure.

Changed
This icon is green with a check mark in it. An attribute of the device has changed. For example, the licensed internal code level may have changed. You can display the Event Monitor window and look for entries for this device to determine what has changed. You can clear the changed status of the device on the canvas by selecting Clear Changes on the Edit menu on the menu bar.

You can also select Clear Changes from a pop-up menu by right-clicking on any empty space on the canvas.
Degraded
This icon is a circle that is divided into yellow and green halves. The device is not fully operational, the device may operate, but may have limited capabilities.

Good
There is no device state icon for this state. The device is available and fully operational.

Missing
This icon is a red X across the device icon. StorX cannot locate the device. You have removed the device from the storage network, or the host that the device is attached to is not operational or is powered off.

Off-Line
This icon is a circle with a broken connection in it. The device is not available. The device may be off-line, or the host that it is attached to may not be operational or powered off.

Suspect
This icon is a circle with a question mark (?) in it. The status of the device was Missing or Broken, but now has been changed to Good. You can use the Clear Changes menu item under the Edit menu to reset the state indicators. You can display the Event Monitor window and look for entries for this device to determine what has changed.

Note: StorX uses icons to represent device states. You can view these device state icons, and their descriptions, by:
- In the Help menu on the menu bar:
  1. Select How Do I...
  2. Select Work with devices
  3. Select Device state icons.
- In the Help index, select the index entry, 'device state icons'.
- You can also view the device state for a device by double clicking on the device and displaying the Properties window.

Displaying statistics about a management set

You can display statistics that are related to your management set:
- The number of storage networks in your management set.
- The rule file version that is being used to define the supported devices in your management set.
- The last date that you saved your management set.
- The compatibility version of the SSA network agent.

To display statistics about the current management set:
1. Click on File, then Management Set Properties (Current).
2. Click on the General tab on the Management Set Properties window to view the Statistics portion of display.
Identifying missing connections

StorX displays the connections between the devices in a management set as solid lines. When you are using the Live Viewer, StorX displays the missing connections as broken (red, dashed) lines.

Clearing changes in a management set

When you are using the Live Viewer, you can clear the device state indicators on the device icons by selecting Clear Changes. Clear Changes resets any StorX indicators such as New, Suspect, and Missing Attributes. When you select Clear Changes, you are acknowledging the changes that have occurred in the storage network. You are also instructing StorX to flag any changes that occur after you select Clear changes on the next management set refresh.

When you select Clear Changes, StorX will ask you if you want to delete all the missing devices. Click OK to remove the missing devices from your management set.

To clear the current device state indicators in your management set, on the menu bar, click on Edit, then Clear Changes.

You can also right click on the canvas and select Clear Changes on the pop-up menu.

Deleting missing devices in a management set

When you are using the Live Viewer, you can choose to remove the devices or storage networks that are marked as missing.

To remove the missing devices or storage networks in your management set, on the menu bar, click on Edit, then Delete Missing. StorX deletes all devices in the storage network with a status of Missing.

You can also right click on the canvas, then click on Delete Missing on the pop-up menu.

Contrast with “Deleting objects in a management set” on page 23.

Discovering a storage network

Discover Storage Networks enables you to add new hosts and rediscover the storage network to include the hosts that you added to the hosts list. Discover Storage Networks only initiates a discover operation if a new host has been added to the management set.

If you have not added any new hosts to the storage network and want to rediscover the storage network, select Refresh Storage Networks in the Management Set menu.
Starting and stopping automatic refresh

If Event Forwarding is selected, StorX will automatically start a refresh discover a short time after an event is detected in your current storage network. The events that will start an automatic refresh are a topology change, error event, or a logical disk change event.

You can cancel the automatic refresh operation by clicking on the Cancel button on the Automatic Refresh message window.

Automatic refresh is disabled if Event Forwarding is disabled.

Refreshing a storage network

When you are using the Live Viewer, you can update the status of the devices and connections in the management set. To update the state of the management set, select Refresh Storage Networks, on the menu bar, then select the type of refresh operation you want:

- Full Refresh Storage Networks
- Topology Refresh Storage Networks

Performing a full refresh of a storage network

To perform a full refresh of the storage network:
1. On the menu bar, click on Management Set.
2. Then select Refresh Storage Networks.
3. Click on Full Refresh Storage Networks.

Performing a topology refresh of a storage network

To perform a topology refresh of the storage network:
1. On the menu bar, click on Management Set.
2. Select Refresh Storage Networks.
3. Click on Topology Refresh Storage Networks.

Notes:
1. The Topology Refresh Storage Networks option is not available if Event Forwarding is selected.
2. You should always perform a full discover or refresh before creating a management set report. This will ensure that your report contains all of the data that StorX can report about your storage network.

Deleting objects in a management set

If you are using the Planner, delete removes an individual object, or group of objects, on the canvas. To delete an object on the canvas, highlight the object and click on the Delete icon on the toolbar.

If you are using the Live Viewer, you can only delete objects with a status of Missing, or manually added enclosures.
The Delete selection in the Edit menu performs the same function.

Contrast with "Deleting missing devices in a management set" on page 22.

---

**Viewing a large management set**

If you cannot view the entire management set on your display, click on the Pan To icon on the toolbar. The Pan To window displays the management set in a size that is slightly less than your desktop window. Click anywhere in the Pan To image to close the Pan To window. StorX then positions the storage network to the location that corresponds to where you clicked.

The Pan To selection in the View menu performs the same function.

---

**Working with the Storage Network Navigator**

The Storage Network Navigator is a separate window that enables you to work with a storage network, or multiple storage networks. You cannot open the Storage Network Navigator until a management set is opened. You can use the Storage Network Navigator to perform the following:

- Specify which storage networks you want displayed on the canvas.
- Identify the status of a storage network and the devices within the storage network.
- Perform group actions such as, hide, show, highlight, and delete, against a storage network, or multiple storage networks.
- Access the properties of a storage network.

To display the Storage Network Navigator:

1. On the menu bar, click on Management Set.
2. Then click on Storage Network Navigator.

If you are using the Live Viewer, StorX updates the Storage Network Navigator display when an event occurs.

The Storage Network Navigator display has the following fields:

**Name**

The name of the storage network.

If there is a device on the canvas that is not attached to an adapter, it is identified as part of a default storage network. There can only be one default storage network listed, and its name is always <Default>.

Although these unattached devices are not part of a valid storage network, StorX treats the default storage network like other storage networks. The exceptions are that you cannot rename the default storage network and you cannot hide it in the Planner.

**State**

StorX displays the state of each storage network. StorX displays the most severe state of the devices in the storage network. The explanation of each state follows:
Attention
One or more of the devices or enclosures in the storage network are in the Attention state. The Attention state is not a failure condition, but is a condition of which you should be aware.

Broken
One or more of the devices, enclosures, or connections in the storage network are in a Broken or Unknown state.

Changed
One or more of the devices, enclosures, or connections in the storage network have the following status; New, Changed, Suspect, or Missing. If the device status is New, Changed, or Suspect, you can clear the status by selecting Clear Changes on the Edit menu on the menu bar. If the device status is Missing, you can clear the storage network status by selecting Delete Missing on the Edit menu on the menu bar.

Degraded
One or more of the devices, enclosures, or connections in the storage network are in an off-line state, or they are not fully operational. The device or connection may operate, but may have limited capabilities.

Exposed
One or more of the RAID arrays in the storage network are broken.

Good
The devices, enclosures, and connections in the storage network are fully operational. This is the default state if you are using the Planner.

Missing
StorX cannot locate the storage network. The reasons for this can be:
• You deleted the storage network.
• You split the storage network into sub networks when you removed a connection.
• You combined the storage network with another storage network when you added a connection.
• The host that you attached the storage network to is not operational or is powered off.

New
StorX identifies the storage network as new if StorX has recently discovered it, or you added or removed a connection from the storage network.

Unknown
StorX is unable to determine the state of the storage network.

Status
The storage network can be synchronized or unsynchronized. When the status of a storage network matches the current state of that storage network, it is synchronized. If the storage network is unsynchronized, one or more devices or connections in the storage network do not reflect their current condition. StorX shades the background of the storage network icon to indicate that it is unsynchronized.

Display
This indicates if the storage network is visible or hidden on the canvas.
Showing or hiding a storage network

You can display or hide a storage network by using the Storage Network Navigator.

To display or hide a storage network:
1. Display the Storage Network Navigator by selecting Management Set on the menu bar and clicking on Storage Network Navigator.
2. In the Storage Network Navigator window, click on the icon of the storage network that you want to show or hide.
3. Click on the Show or Hide button.

You can select multiple storage networks to show or hide by doing the following:
1. Hold down the Shift key while clicking on the icons of the storage networks that you want to show or hidden.
2. Click on the Show or Hide button.

Deleting a storage network

You can delete a storage network by using the Storage Network Navigator. If you are using the Live Viewer, you can only delete storage networks with a state of Missing. If you are using the Planner, you can delete any storage network in the management set.

To delete a storage network:
1. Display the Storage Network Navigator by selecting Management Set on the menu bar and clicking on Storage Network Navigator.
2. In the Storage Network Navigator window, click on the icon of the storage network that you want to delete.
3. Click on the Delete button in the Storage Network Navigator window.

You can delete multiple storage networks by doing the following:
1. Hold down the Ctrl key while clicking on the icons of the storage networks that you want to delete.
2. Click on the Delete button.

Highlighting a storage network

To highlight the host and adapters that are associated with a storage network in the currently displayed management set:
1. On the menu bar, click Management Set, then click Storage Network Navigator.
2. When StorX displays the Storage Network Navigator display, click on a storage network icon, then click on the Highlight button. StorX will highlight that storage network on the canvas, if the storage network is visible.
3. You can also view the properties of the selected storage network by clicking on the Properties button.
4. Click on the Hosts tab of the Storage Network Properties window to display the hosts and adapters that are associated with that storage network.
Displaying the state of a storage network

You can display the state of any storage network in your management set, by using the Storage Network Navigator.

To display the state of a storage network:
1. On the menu bar, click Management Set, then click Storage Network Navigator.
2. StorX displays the state of each storage network in the State column in the Storage Network Navigator window. The storage network states are described in "Working with the Storage Network Navigator" on page 24.

Renaming a storage network

To rename a storage network:
1. From the menu bar, select Management Set, then Storage Network Navigator.
2. Click on the icon of the storage network you want to rename and click on Properties.
3. On the General tab of the Storage Network Properties window, you can type in the new name of the storage network and add a description.

Notes:
- StorX will not allow duplicate names for storage networks.
- StorX will not allow you to rename the default storage network.

Exporting a management set

You can save the contents of a management set as an image file (GIF or BMP). If your management set is large, your system’s resources may limit your ability to export a management set.

To export a management set:
1. On the menu bar, click on File, then Export.
2. Click on the format (BMP or GIF) in which you want to save the management set.

Note: GIF exports will only work if you set your display to less than or equal to 256 colors.
3. Type the name of the exported image file.

For information on exporting report data from a management set, see "Chapter 10 Creating management set reports" on page 53.

Merging management sets

You can merge Planner or Live Viewer management sets with a Planner management set.

Note: If you created the management set you are trying to merge with a newer version of StorX, the merge operation will fail. StorX will issue a message that states that you should upgrade to the newer version of the program.
When you merge a management set, the storage networks in that management set may appear differently on the canvas than when you saved that management set. When the Merge operation completes, StorX displays the management sets as separate storage networks on the canvas.

When you merge management sets, StorX removes any text or box annotations that are not associated with a device.

If you are merging management sets that contain the same host name or storage network name, StorX renames the identical host names and storage network names to a unique name.

When you merge a management set that is created by the Live Viewer, StorX migrates the management set to a Planner management set. When StorX migrates the management set, StorX removes the following:
- Host-based attributes.
- Logical disk information.
- Logical volume information.
- Unknown devices that are not connected to any other devices.
- All device state information.
- All unassociated annotations.

To merge a management set with an existing open Planner management set:
1. On the menu bar, click on File, then click on Merge to display the Merge Management Set window.
2. Specify the management set you want to merge with the currently displayed management set.

Saving a management set

This selection saves the current management set without changing the file name or directory. If you have not saved the management set previously, StorX prompts you to enter the file name and directory.

To save a management set, click on the Save icon on the toolbar. If the management set is new and is unnamed, StorX displays a window for you to specify a name for the management set.

You cannot save a management set without naming it.

StorX saves Planner management sets with a file extension of .SPS. StorX saves Live Viewer management sets with a file extension of .SLS.

Copying a management set

You can make a copy of a management set by saving it with a different name by using the Save As function. When you use Save As to rename a management set, StorX closes the current management set and does not update it. StorX changes the name of the currently loaded management set on the StorX title line.

To make a copy of a management set:
1. On the menu bar, click on File, then Save As.
2. Type in the new name in the Save Management Set window.

Closing a management set

To close a management set, select Close from the File menu. StorX reminds you to save or discard any changes before closing the management set. If you are using the Live Viewer, StorX will stop monitoring for events and clear the Event Log Monitor and canvas.

Exiting StorX

To exit StorX, on the menu bar, click on File, then Exit. StorX reminds you to save or discard any changes before closing the management set before exiting the program.
Chapter 4. Using event forwarding

You can have StorX automatically notify you when events occur while StorX is monitoring your storage network.

Note: To have StorX notify you of storage network events, you must have Microsoft Simple Network Management Protocol (SNMP) installed and active on the StorX manager. To install, configure and start or stop the SNMP service, refer to the appropriate SNMP information for your system.

When you start StorX, the event notification setting is based on the setting when you previously used StorX.

What is SNMP?

Simple Network Management Protocol (SNMP) is an industry standard management protocol that originated for TCP/IP networks. SNMP is a series of Requests for Comments (RFCs) that specifies and structures the information that is exchanged between managing and managed systems.

SNMP MIB variables and events

All StorX SNMP traps are identified with an event ID. For example, the highlighted number (13), in the following example, is an event ID.

Additionally, a list of the various StorX MIB (Management Information Base) variables is included.

Following is an example of a typical SNMP trap:

Received trap - generic=6 specific=13 >> from agent -> 9.5.156.93
Variable = .iso.org.dod.internet.private.enterprises.2.6.161.2.1.1
Value = OCTET STRING - xxxxxxx.xxxxxxx.ibm.com
Variable = .iso.org.dod.internet.private.enterprises.2.6.161.2.1.2
Value = OCTET STRING - 272
Variable = .iso.org.dod.internet.private.enterprises.2.6.161.2.1.3
Value = OCTET STRING - Build: RXXXX

Note: The following lists the description portion of the MIB object. StorX uses the description of .iso.org.dod.internet.private.enterprises. to precede the following MIB variables.

Table 1. StorX MIB Explanations

<table>
<thead>
<tr>
<th>StorX MIB Variable</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.6.161.2.1.1</td>
<td>(storxHostName) The name of the host that StorX is running on.</td>
</tr>
<tr>
<td>2.6.161.2.1.2</td>
<td>(storxProcessID) The process ID of the StorX manager software.</td>
</tr>
<tr>
<td>2.6.161.2.1.3</td>
<td>(storxVersionID) The version of StorX that you are running.</td>
</tr>
<tr>
<td>2.6.161.2.1.4</td>
<td>(storxManagementSetName) The filename of the active management set that StorX is running.</td>
</tr>
<tr>
<td>2.6.161.2.2.1</td>
<td>(eventTimeStamp) The timestamp of the SNMP trap.</td>
</tr>
</tbody>
</table>
Table 1. StorX MIB Explanations (continued)

<table>
<thead>
<tr>
<th>StorX MIB Variable</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.6.161.2.2.2</td>
<td>(event Category) The category of the StorX SNMP trap.</td>
</tr>
<tr>
<td>2.6.161.2.2.3</td>
<td>(eventType) The event type of the SNMP trap.</td>
</tr>
<tr>
<td>2.6.161.2.2.4</td>
<td>(eventText) The event description of the trap</td>
</tr>
<tr>
<td>2.6.161.2.2.5</td>
<td>(eventDevice) The device associated with the event.</td>
</tr>
</tbody>
</table>

The following are SNMP-forwarded event IDs. You can determine what caused some of these events by reviewing the entries in the StorX Event Log. Additionally, you should review the message that is issued when the event occurred and take appropriate action.

Reserved (Event ID 0–9)
None

StorX - Critical (Event ID 10)
StorX has detected a problem that could affect the storage network discovery results. Possible causes are:
- An excessive utilization of the target host processor has prevented StorX from gathering information.
- TCP/IP communication problems.
- StorX is incompatible with the network agent-level.

If you encounter this situation you should perform a Refresh Storage Networks operation. Take corrective action.

StorX - Warning (Event ID 11)
StorX may not be displaying some auxiliary information correctly. StorX may be incompatible with the network agent level or the management set level. Take corrective action.

StorX - Cleared (Event ID 12)
StorX has cleared a warning or critical situation.

StorX - Information (Event ID 13)
Informational messages denote progress or activity status.

Reserved (Event ID 14–19)
None

Network - Critical (Event ID 20)
The storage network topology has changed or a device state has degraded. Look at the devices that have changed status in your storage network. When you understand the device changes that have occurred, you can reset the device status by selecting Clear Changes from the Edit menu. Take corrective action.

Network - Warning (Event ID 21)
A device attribute has changed or an agent event has been received. There is a problem with the storage network or a device within it. Take corrective action.

Network - Cleared (Event ID 22)
StorX has cleared a warning or critical situation.

Network - Information (Event ID 23)
Informational messages denote progress or activity status.
Starting or stopping event forwarding

To start or stop SNMP event forwarding, on the menu bar, click on Tools, then select Event Forwarding. This is a toggle switch and will enable or disable SNMP event forwarding.

When you stop event forwarding, StorX issues a message confirming that events will not be forwarded. You can choose to cancel this request and continue with event forwarding.

The Topology Discover function is disabled when Event Forwarding is selected.
Chapter 5. Working with hosts

Hosts are computers that communicate with StorX. A host can be running the AIX or Windows NT operating system. A host must have an SSA network agent that is installed.

When you are discovering storage networks, you must enter a complete list of the hosts you want included.

Adding a host to a management set

You can add a host, or several hosts to an existing storage network. If you are using the Live Viewer, StorX will check to see if the host you specified is active. To add one or more hosts to a storage network:

1. On the menu bar, click Management Set, then click Hosts, to display the Management Set Hosts window.
2. Type the fully qualified host name, or the TCP/IP address, of all the hosts you want in the management set in the Add New Host box. Click the Add button when after entering the name of each host.
   - If you are using the Planner, StorX will accept any host name you specify.
   - If you are using the Live Viewer, StorX verifies that the host exists and has an SSA network agent installed. StorX then adds the host name to the Hosts in Management Set list box. If StorX cannot verify that the host exists, StorX will ask you if you want to add the host anyway.
   - If you enter an unqualified host name, StorX will qualify the host name with the selected domain.
   - You can also select the domain you want associated with a host from the Qualify with domain list.
   - You can add new domains by entering a fully qualified host name with a new domain.
3. StorX displays the name of the host you added under the Menu item Management Set, Host.

Note: Ensure that you list all the hosts that you want included in your Live Viewer management set. When StorX discovers a storage network, the adapters that are attached to storage networks that are not in the host list maybe displayed as Unknown.

See “Working with the Storage Network Navigator” on page 24 for a description of the unknown state.

Deleting a host from a management set

You can remove a host, or hosts, from the management set by performing these steps.

1. On the menu bar, click Management Set, then click Hosts, to display the Management Set Hosts window.
2. Click on the name of the host you want to remove, to highlight the host name, and then click Delete.

**Note:** If you are using the Live Viewer, you can only delete hosts that are not associated with any storage network in the management set.

---

### Displaying the host operating system

When you are using the Live Viewer, you can determine what operating system that is on any of the hosts in your storage network. To display this information:

1. On the menu bar, click Management Set, then click Hosts.
2. Highlight a host name in the Hosts in Management Set box by clicking on it.
3. Click on the Properties button to display the General tab of the Host Properties window.
4. StorX displays the operating system and version in the Operating System section of the General tab.

### Displaying the state of a host

When you are using the Live Viewer, you can display the state of any host in your management set.

To display the state of a host:

1. On the menu bar, click Management Set, then click Hosts.
2. Highlight a host name in the Hosts in Management Set box by clicking on it.
3. Click on the Properties button to display the General tab of the Host Properties window.
4. StorX displays the state of the host in the Status section of the General tab.

StorX assigns the following states to a host:

- **Attributes Modified**
  - The attributes of the host have changed.
- **Good**
  - The host is available and fully operational
- **Missing**
  - The host is not available. The host may have been removed from the storage network or powered off.
- **New Host**
  - You have recently added the host to the management set.
- **New, Attributes Modified**
  - The host is new to the management set, and the host’s attributes changed.
- **Suspect**
  - The host was previously identified as Broken, Degraded, or Missing, but is now available.

### Displaying the version date of the SSA network agent on a host

You can use the Live Viewer, to display the SSA network agent version date that is installed on any of the hosts in your management set. To display this information:
1. On the menu bar, click Management Set, then click Hosts, to display the Management Set Hosts window.
2. Click on a host in the Hosts in Management Set box.
3. Click on the Properties button to display the General tab of the Host Properties window. The date and time of the SSA network agent is displayed in the StorX section of the General tab.

Finding adapters installed on a host

When you are using the Live Viewer, you can find any adapter that is installed on a host by highlighting the adapter in the management set.

To highlight an adapter:
1. On the menu bar, click Management Set, then click Hosts, to display the Management Set Hosts window.
2. Highlight a host name in the Hosts in Management Set box by clicking on it.
3. Click on the Properties button then click on the Adapters tab of the Host Properties window.
4. StorX then displays the Adapters tab of the Host Properties window. Click on a single adapter or click on the Select All button to select the adapter you want to find.
5. Click on Highlight and StorX will highlight (shade) the adapter that you have chosen on the management set display.

Displaying logical disk information for a host

When you are using the Live Viewer, you can display logical disk information that is related to a specific host. To display this information:
1. On the menu bar, click Management Set, then click Hosts, to display the Management Set Hosts window.
2. Highlight a host name in the Hosts in Management Set box by clicking on it, then click on the Properties button.
3. When StorX displays the Host Properties window, click on the Logical disk tab.
4. When the Logical Disk tab is displayed, click on a logical disk, then click on the Properties button.
5. When the Logical Disk Properties window is displayed, click on the System tab.
6. In the Host Name field, select the host for which you want logical disk information.
   StorX displays the name of the logical disk, its status, and the physical disks that make up the logical disk.
   You can also click on a physical disk in the Physical Disks section, and then click on Highlight. This will highlight (shade) the disk in the management set so you can find it.
Chapter 6. Working with devices

This section discusses the various tasks that are associated with the devices in your storage network.

Determining the devices StorX supports

To determine what devices (disks units, adapters, enclosures, and cables) that StorX supports:
1. On the menu bar, click on File, then Management Set Properties (Current or New).
2. Click on the appropriate device tab.
3. View the types of devices that are supported by clicking on the default device type list button.

Specifying the default adapters for a Planner management set

When you are using the Planner, you can specify the type of adapters that you add to your Planner management set.

You can quickly specify the default for items that want in your current management set by using the Parts Palette. To specify the default you want used in your current management set perform the following steps:
1. On the Parts Palette, place the pointer next to the icon to which you want to specify defaults.
2. Click on the arrowhead symbol in the icon, or right click anywhere on the icon, to display the default selections available to you.
3. Select the default for the item you will be adding to your management set.

If you would like to set the default properties for items you add in a new management set, see “Specifying defaults for new management sets” on page 15.

Adding an adapter to a Planner management set

To add an adapter to a Planner management set:
1. Click on the Add Adapter icon on the Parts Palette.
2. Move the pointer to where you want to place the adapter and click.

Specifying the default disks for a Planner management set

You can quickly specify the default for items that want in your current management set by using the Parts Palette. To specify the default you want used in your current management set perform the following steps:
1. On the Parts Palette, place the pointer next to the icon to which you want to specify defaults.
2. Click on the arrowhead symbol in the icon, or right click anywhere on the icon, to display the default selections available to you.
3. Select the default for the item you will be adding to your management set.

If you would like to set the default properties for items you add in a new management set, see \textquote[Specifying defaults for new management sets]{Specifying defaults for new management sets} on page \pageref{Specifying defaults for new management sets}.

### Adding a disk to a Planner management set

To add a disk to a Planner management set:

1. Click on the Add Disk icon on the Parts Palette.
2. Move the pointer to where you want to place the disk and click.

### Specifying the default connections for a Planner management set

You can quickly specify the default for items that want in your current management set by using the Parts Palette. To specify the default you want used in your current management set perform the following steps:

1. On the Parts Palette, place the pointer next to the icon to which you want to specify defaults.
2. Click on the arrowhead symbol in the icon, or right click anywhere on the icon, to display the default selections available to you.
3. Select the default for the item you will be adding to your management set.

When you are using the Planner, you can specify the type of cables you want to use to connect the devices in your Planner management set.

If you would like to set the default properties for items you add in a new management set, see \textquote[Specifying defaults for new management sets]{Specifying defaults for new management sets} on page \pageref{Specifying defaults for new management sets}.

### Connecting devices in a Planner management set

To connect the adapters and disks while using the Planner:

1. Select the Connection icon on the Parts Palette and click on the adapter or disk where you want to start the connection. If you are starting or ending your connection to an adapter, StorX prompts you to select the port number.
2. Move the mouse to the adapter or the disk that you want connected, and click. If StorX cannot determine which device port to connect, StorX prompts you to select a port.

To cancel a connection, press ESC or click on an unoccupied place on the canvas.

StorX draws a connection as a straight line between the connected objects. Sometimes, the connections will seem to pass through other objects that are in the way. To route the connection around an object, click on the Select icon, then press and hold mouse button 1 over the connection. When you select the connection, a small box, that is called a midpoint, is placed under the mouse pointer. Drag the midpoint to move the connection. The connection will move between adjacent midpoints or objects along the connection.
Deleting connection midpoints

A connection midpoint occurs when a connection from one device to another is not a straight line. Connection midpoints are added to the canvas as part of a Layout operation or when devices are manually repositioned on the canvas.

You can remove these connection midpoints while using the Planner or the Live Viewer by:
1. Right clicking on the connection line to display the Connection pop-up menu.
2. Select Remove Midpoints, to remove the connection midpoints in this link of the connection. StorX will then redraw the connection, and the connection will run directly between two devices.

You can select more than one connection, by pressing and holding the Ctrl key and clicking on multiple connection lines. If you select more than one connection, StorX will remove the midpoints from all of the selected connections.

Note: If a device is connected to itself, removing the midpoints from a connection will remove all the midpoints. StorX will then add three midpoints so the connection is visible. StorX does not support connecting a device to itself, but may encounter this in a discovered network.

Displaying the state of a device

When you are using the Live Viewer, you can display the state of any device in your management set.

To display the state of a device:
1. Right click on the device on the canvas, and select Properties.
2. StorX displays the state of the device in the Status section of the General tab.

See “What are the device states?” on page 20 for a description of the device states.

Displaying device properties

You can display detailed information about any adapter, disk, or connection by double-clicking on the device.

You can also display the device properties by double-clicking on the device.

Selecting the device information you want displayed

You can select the device information you want displayed by the device icon on the canvas. For example, you can select to display the capacity of each disk by the corresponding disk icon. You can also select to display the capacity, external label, logical disk, name, and type of disk by the disk icon on the canvas.

To specify the information you want displayed by the device icon on the canvas:
1. On the menu bar, click on File, then Management Set Properties (Current).
2. Click the Management Set Properties window tab that describes the device you want to work with.
3. Press and hold the Ctrl key and click on each device attribute that you want displayed by the device icon on the canvas. StorX determines the sequence that these attributes are listed under each device on the canvas, by the order that you selected them.

If you would like to set the default device properties for any new management sets that you create in the future, see "Specifying defaults for new management sets" on page 13.
Chapter 7. Working with enclosures

An enclosure contains one or more devices (usually disks). An enclosure can be a rack-mounted or a stand-alone unit. Enclosures provide external connectors to the internal devices that are mounted within the enclosure.

StorX works with the following types of enclosures:

- SES enclosure: This is an SSA SCSI Enclosure Services (SES) enclosure that StorX can discover and interrogate. Discovered enclosures use the StorX network agent to identify themselves and their contents. StorX adds discovered enclosures to the canvas as part of the storage network discovery process. StorX can only discover an enclosure, if the enclosure contains at least one DSI disk. The enclosure must also be attached to a host that contains an adapter and a network agent that supports SES enclosures.

  Note: DSI (Device Services Interface) is the interface between each device and the controller in an SES enclosure. This interface enables the system to communicate across SSA to a device (with DSI support) and through DSI to the enclosure (controller). This communication provides the ability to retrieve status, VPD, and other settings from the enclosure.

- Non-SES enclosure: This is an enclosure that you have manually added to the management set. A manually added enclosure is unable to report information about itself to StorX.

Working with enclosures in the Planner

When you are using the Planner, you can use the Parts Palette to add empty enclosures or fully populated enclosures. For more information, see "Automatically populating enclosures" on page 48.

Once the enclosures are on the canvas, you can add or remove devices and blanks from the enclosures. You can also delete the enclosure from the management set. You can also make connections to the enclosure and between the devices in the enclosure.

Working with enclosures in the Live Viewer

StorX allows you to perform different actions on the enclosures, depending on which type of enclosure you are using.

Working with manually added enclosures

You can manually add enclosures while using the Live Viewer or the Planner with the following guidelines:

- You can add or remove devices and blanks from the enclosures.
- You can delete the enclosure from the management set.
- You cannot add fully populated enclosures to a Live Viewer management set.
- You cannot add or remove connections to the enclosure, while using the Live Viewer.
If you manually add a SES enclosure, StorX will consider it a non-SES enclosure. StorX displays the manually added SES enclosure with a gray background and you will be able to add or remove devices, as well as delete the enclosures. StorX will only recognize enclosures it discovers as SES enclosures. StorX does not allow you to add or remove devices or delete an enclosure that it discovers, unless it has a state of Missing.

StorX automatically moves disks from a manually added enclosure to the appropriate discovered enclosure during the discovery process. For example, if you manually add an enclosure to a Live Viewer management set and populate it with disks. Then, during the discovery process, a discovered enclosure reports that it contains those disks; StorX will change the disk placement. StorX will remove the disks from the manually added enclosure and place them in the discovered enclosure. StorX will not automatically delete the manually added enclosure that previously contained the disks.

**Working with discovered enclosures**

When StorX detects an enclosure during the discovery process, StorX adds the enclosure to the management set. You cannot change any of the information that the enclosure has reported during discovery.

StorX indicates discovered enclosures in the following ways:

- Discovered enclosures are displayed with a lightning bolt by the lower left corner of the enclosure. StorX displays manually added enclosures without the lightning bolt symbol.
- Discovered enclosures have a state identifier icon by the lower right corner of the enclosure. If the state of the enclosure is Good, StorX does not display a device state icon. See "What are the device states?" on page 20 for more information.

**Note:** For SES enclosure functions to be available to you, the SES enclosure must be connected to an adapter that supports SES enclosure functions. For Windows NT 4.0, the disk drive identify function only works if the enclosure is connected to an adapter that supports SES enclosure functions.

When you merge a Live Viewer management set, containing discovered enclosures, into a Planner management set the discovered enclosures are changed to manually added enclosures. Additionally, if you open a Live Viewer management set with the Planner, the discovered enclosures are changed to manually added enclosures.

---

**Adding an enclosure to a management set**

You can add enclosures to your management set while using the Planner or the Live Viewer. To specify the type of enclosure that you want to add, see "Specifying the default enclosures for a management set" on page 45.

To add an enclosure to a Planner or Live Viewer management set:

1. Click on the Add Enclosure icon on the Parts Palette.
2. Move the pointer to where you want to place the enclosure and click to add the enclosure icon to the management set.
Deleting an enclosure

You can delete an enclosure from your management set. When you delete the enclosure, StorX deletes all devices in the enclosure, along with the connections to those devices. If you are using the Live Viewer, StorX only deletes the missing devices and their connections in the enclosure.

The connections that are deleted are those that were connected to devices within the enclosure. If there was a connection to blanks in the enclosure, StorX will try to reroute those connections. For example, if an enclosure is populated with blanks and is connected to other enclosures, the deleted connections to blanks in the enclosure are rerouted. This happens when the enclosure, and the blank connections are deleted. The other enclosures that were connected to each other, and the deleted enclosure, will keep their connections with each other.

If there are annotations that are associated with the deleted enclosure and devices, StorX asks if you want to delete those annotations.

You can delete any enclosure in a Planner management set.

You can only delete enclosures that are marked as Missing in a Live Viewer management set, or that you manually added. Also, you cannot delete a split enclosure, the enclosure must be joined before you can delete the enclosure.

To delete an enclosure:
1. Click on the Select icon on the Parts Palette.
2. Click on the enclosure icon on the canvas that you want to delete.
3. Click on the Delete icon on the toolbar.

Specifying the default enclosures for a management set

You can specify the type of enclosures you want to use in your management set.

You can use the Enclosures tab to specify that you want to add the enclosure empty or populated (Planner only) with disk units. If you are using the Live Viewer, the enclosure is always empty when you add it. The type of disks that will populate the enclosure, are the default disks you specified on the Disks tab in the Management Set Properties window.

You cannot change the type of enclosure if the current enclosure contains any devices, or there are any connections to the enclosure.

You can quickly specify the default for items that want in your current management set by using the Parts Palette. To specify the default you want used in your current management set perform the following steps:
1. On the Parts Palette, place the pointer next to the icon to which you want to specify defaults.
2. Click on the arrowhead symbol in the icon, or right click anywhere on the icon, to display the default selections available to you.
3. Select the default for the item you will be adding to your management set.
If you would like to set the default device properties for any new management sets that you create in the future, see "Specifying defaults for new management sets" on page 13.

Displaying or hiding enclosures

You can choose to display or hide the enclosures. If you choose to hide the enclosures, StorX will still display the disk units that are in the enclosures.

If you select Show Enclosures, StorX displays all enclosures in the management set, with the disk units in them. If you are using the Live Viewer, new enclosures that are found during discovery are displayed.

If you deselect Show Enclosures, StorX hides all enclosures currently in the management set. The icons for the disk units, that are contained in the enclosures, are displayed. When you hide the enclosures, StorX only displays new enclosures that you add from the Parts Palette. If you are using the Live Viewer, new enclosures that are found during discovery are not displayed.

StorX determines the visible state of an enclosure, when loaded, by how StorX previously saved the enclosure. The View menu item, Show Enclosures, always defaults to the Show Enclosures (visible) setting. This may not match what StorX is currently displaying in the management set.

To select, or deselect Show Enclosures, on the menu bar, click on View then, Show Enclosures.

Displaying enclosure properties

You can display detailed information about an enclosure by displaying the Enclosure Properties window. The Enclosure Properties window has the following page tabs:

- General: Displays specific information about the enclosure. You can also enter a text description of where the enclosure is located.
- Description: Displays information about specific enclosure types. When the enclosure is empty, you can access this tab and change the type of enclosure by using the selections in the Enclosure Type field. The enclosure must be empty before you can change the enclosure type.
- System: Displays information about the devices in the enclosure. The information varies, depending on whether the enclosure has been manually added or discovered.
- Advanced: Displays information about specific states and attributes for the enclosure types. If you are using the Live Viewer, you can click on an Identify button to turn on the enclosure identify lights.

To access the enclosure properties window:

1. Select an enclosure icon, enclosure section, or a group of enclosures.
2. Click on your selection with mouse button 2 and select Properties from the pop-up menu.
Splitting or joining enclosures

You can split the enclosures in your management set into sections. When you split an enclosure into sections, StorX removes the enclosure icon from the canvas and replaces it with an icon representing enclosure sections. StorX displays the enclosure sections on the canvas if:

- The enclosure section contains any device that is located in a storage network that is not hidden.
- The enclosure can be split; some types of enclosures cannot be split into sections.

To split an enclosure into sections, or to join the sections together to form an enclosure:

1. Position the mouse over the enclosure icon, or enclosure section icon, you want to split or join, and click the right mouse button.
2. When the pop-up menu appears, click on Split. StorX then splits the enclosure into sections and labels each section with a drawer number and section number. For example, the first section of enclosure 5 would be labeled, Enclosure 5:1.

To join the enclosure sections, right click on any enclosure section and click on Join in the pop-up menu.

Adding a device to an enclosure

You can add devices to an enclosure under the following conditions:

- While using the Planner, you can add devices to any enclosure.
- While using the Live Viewer, you can add devices to a manually added enclosure or a discovered enclosure that did not identify the location of the devices. This situation may occur if the devices are not known to the host. See “Determining device states in an enclosure” on page 48 and “Handling SSA topology changes” on page 62 for more information.

When you add a device, StorX will determine what slots in the enclosure are compatible with the device you are trying to add. Because of this, StorX will only make specific enclosure slots available to you, even though many of the slots may be empty. StorX is aware of how the device connects to other devices. Because of this, StorX will only allow a device to be placed in an enclosure slot that is compatible with how that device is connected.

You can only add individual devices to an enclosure.

To add a device that is already on the canvas to an enclosure:

1. Drag the device and drop it on the enclosure.
2. StorX will display a pop-up menu.
3. Select the slot in which you want to place the device. StorX displays all of the slot numbers, but only shows the available slots as active slots on the pop-up menu. If the device type you are trying to add to the enclosure is not a valid device type, StorX will display a message that states so.

To add a new device directly to an enclosure:

1. Select the Add Disk icon.
2. Place the mouse pointer over an enclosure and click.
3. StorX will display a pop-up menu.
4. Select the slot in which you want to place the device. StorX displays all of the slot numbers, but only shows the available slots as active slots on the pop-up menu. If the device type you are trying to add to the enclosure is not a valid device type, StorX will display a message that states so.

### Automatically populating enclosures

If you are using the Planner, you can have StorX automatically add fully populated enclosures to the canvas. To have the enclosures that you add to your management set automatically populated with disks:

1. On the menu bar, click on File, then Management Set Properties (Current).
2. Click on the Enclosures tab on the Management Set Properties window.
3. Check the box that is titled Populate with drives when added to plan if you want StorX to automatically add disks to the enclosures you add.

If you would like to set the default device properties for any new management sets that you create in the future, see "Specifying defaults for new management sets" on page 13.

### Determining device states in an enclosure

The enclosure, or enclosure sections, can contain devices or non-devices (blanks and empty slots). StorX represents the state of the devices as colored circles and the non-devices as colored squares. See "What are the device states?" on page 20 for more information.

The colors, and states, of the devices in the enclosures are:

**Note:** See the Device state icons topic in the on-line information to view the actual device state icons.

- Green – the device state is Good state or there is no state assigned.
- Yellow – the device state is Degraded or Suspect.
- Red – the device state is Broken or Missing.
- Gray – the device is detected but not discovered. A detected, but not discovered device is a device that was reported in a slot by a discovered enclosure, but not in the discovered topology. The status of detected, but not discovered can be caused by:
  - An incomplete host list during the discovery process.
  - Discovering a host that does not contain adapters or agents that support SES enclosures.

The colors of the non-devices in the enclosures are:

- White square – Empty slot.
- Gray square – there is a blank in the slot.
Connecting devices to an enclosure

In the Planner, you can connect any free port on an enclosure to any device on the canvas that has a free port. You can also connect an enclosure to another enclosure.

To connect devices to an enclosure:
1. Select the Connection icon on the Parts Palette and click on the enclosure, or enclosure sections, to which you want to connect a device. StorX will display the ports on the enclosure that are available.
2. Select a port and then move the mouse pointer to the device, or enclosure, or enclosure sections, that you want to connect to the enclosure.
3. If StorX cannot determine which device port to connect to, StorX will prompt you to select a device port.

To cancel a connection, press ESC or click on an unoccupied place on the canvas.

Connecting an enclosure to another device or enclosure

If you are using the Planner, you can connect devices in an enclosure to any device on the canvas that has a free port.

To connect to a device in an enclosure:
1. Select the Connection icon on the Parts Palette and click on the enclosure that contains the device to which you want to connect. StorX will display the ports on the enclosure that are available.
2. Select a port and then move the mouse pointer to the device, or enclosure, that you want to connect to the enclosure.
3. StorX will prompt you to select a device port if StorX cannot determine which device port to connect to.

StorX overrides the default connection and makes it a bypass connection when you connect two enclosure sections that are capable of a bypass connection. StorX does this to ensure that the connections, in the Planner management set are as efficient as possible. You can change this by accessing the Connection Properties window and changing the connection type to the type.

To cancel a connection, press ESC or click on an unoccupied place on the canvas.

Adding a blank to an enclosure

A blank is an empty disk unit that is installed into enclosure slots to link a slot with adjacent slots or ports. Blanks are used when there are not enough disk units to fully populate the enclosure, but the enclosure requires the internal enclosure connections. Blanks are also used to provide the proper air flow in the enclosure, for cooling.

If you are using the Planner, you can add blanks to any enclosure. If you are using the Live Viewer, you can only add blanks to enclosures that you have manually added to the management set. StorX automatically detects blanks in discovered enclosures.
When you add a blank, StorX will determine what slots in the enclosure are compatible with the blank disk unit.

StorX determines that a slot is available for a blank if you can:
- Connect the devices on either side of the blank.
- Route existing connections through the blank.

To add a blank to an enclosure:
- Position the mouse pointer on the enclosure and right click the mouse.
- StorX will display a pop-up menu. Select Add Blank from the pop-up menu. StorX then displays a window with the slots in which you can place the blank.

**Removing a device or blank from an enclosure**

You can remove devices (disks or blanks) from an enclosure in a management set.

StorX uses the following rules when removing a device from an enclosure:
- You can always remove a blank in a Planner management set. If the blank connected two devices that are in adjoining slots in the enclosure, removing the blank will break that connection. If you route a connection through a blank to a device outside the enclosure, then the connection will remain intact.
- You can remove a blank in a Live Viewer management set if it does not affect the topology of the storage network. If a blank is located between two devices in an enclosure section, then the blank cannot be removed. If a blank is in an end slot in an enclosure section, you can remove the blank.
- You cannot remove a blank from a discovered enclosure while using the Live Viewer.

To remove a device from an enclosure:
- Position the mouse pointer on the enclosure and right click the mouse.
- StorX will display a pop-up menu. Select Remove from the pop-up menu. StorX then displays a window with the slots from which you can choose to remove a device.

**Printing enclosures**

You can print images of the enclosures in your management set. The enclosure labels you have specified in the Enclosure View Preferences window determine the labels that are printed with the enclosures. StorX prints one enclosure on each printed page. Empty slots in an enclosure are printed as white. StorX prints slots with blank devices as shaded. Slots with devices have the device icons printed in the slot with the device labels that you specified in the Disk View Preferences window.

To print the enclosures in your management set click on File, click on Print, and select Enclosures.

If you have any problems when trying to print StorX output to a network printer, refer to “Network printer problems” on page 65.
Chapter 8. Working with logical disks

StorX defines a logical disk as a single physical disk or multiple physical disks. A logical disk represents a logical view of a set of physical disks on the host system.

### Identifying logical disks in a storage network

When you are using the Live Viewer, you can determine the logical disks that are associated with a storage network in the currently displayed management set. To display the logical disks associated with a storage network:

1. On the menu bar, click Management Set, then click Storage Network Navigator.
2. Highlight a storage network in the Storage Network Navigator display, and click Properties.
3. Click on the Logical Disks tab of the Storage Network Properties window to display the logical disks that are associated with the storage network.

### Displaying the description and status of a logical disk

When you are using the Live Viewer, you can display a list of logical disks that are associated with a host. A StorX logical disk is similar to an AIX physical volume (hdisk). You can then select to display the description and status of a logical disk. To view the description and status of a logical disk:

1. On the menu bar, click Management Set, then click Hosts, to display the Management Set Hosts window.
2. Highlight a host name in the Hosts in Management Set box by clicking on the name of a host.
3. Click on the Properties button to display the Host Properties window, then click on the Logical Disks tab of the Host Properties window.
4. Click on a logical disk on the Logical Disks tab of the Host Properties window. Then click on Properties to display the General tab of the Logical Disk Properties window.

The description section of the General tab displays the type, capacity, and serial number of a logical disk.

**Type**

The type number of the logical disk, the logical disk reports this information.

**Capacity**

StorX displays the capacity of the logical disk in MB. It does not take into account any reductions in usable capacity due to any RAID configurations the logical disk may belong to. This field changes based on the logical disk type.

**Serial Number**

The serial number of the logical disk.

The status section of the General tab displays the following information about a logical disk.

**State**

The states of a logical disk are:
• storx state value (This is the StorX state for the device.)
• real state value (This is the state the device reported.)

Synchronized
Yes indicates that the logical disk status is current. No indicates that the logical disk status is not current.

Displaying adapters associated with a logical disk

When you are using the Live Viewer, you can display a list of adapters that are associated with a logical disk. To display this information:

1. On the menu bar, click Management Set, then click Hosts, to display the Management Set Hosts window.
2. Click on a host name, in the Hosts in Management Set box, to highlight the host.
3. Click on the Properties button then click on the Logical Disks tab of the Host Properties window.
4. Click on a logical disk, click on Properties, then click on the Adapters tab on the Logical Disk Properties window.
5. The adapters that are associated with a logical disk are listed. You can also click on an adapter and highlight it in the management set so you can find it.

Displaying detailed information about a logical disk

When you are using the Live Viewer, you can display detailed information about a logical disk. To display this information:

1. On the menu bar, click Management Set, then click Hosts.
2. Click on a host name, in the Hosts in Management Set box, to highlight the host.
3. Click on the Properties button then click on the Logical Disks tab of the Host Properties window.
4. Click on a logical disk, then Properties, then click on the Advanced tab on the Logical Disk Properties window. StorX displays the detailed attributes of a logical disk in the All attributes section of the Logical Disk Properties window.
5. The adapters that are associated with a logical disk are listed. Click the Identify button to locate the logical disk. When you click the Identify button the disk identify light will flash for all physical disks associated with this logical disk. The disk identify light will flash until you close this window or you click the Identify button again.

Click the Refresh button to update the information in the All attributes window.
Chapter 9. Canvas operations

This section discusses the various tasks that are associated with adding, changing or deleting items on the StorX canvas.

Showing or hiding the Parts Palette

You can display or hide the Parts Palette which contains the icons that you use to add objects to a Planner or Live Viewer management set.

To display or hide the Parts Palette, on the menu bar, click on View, then Show Parts Palette. This is a toggle switch and will show or hide the parts palette.

The Parts Palette consists of different icons, depending on whether you are using the Planner or Live Viewer. For example, you are able to add adapters, disks, and connections while using the Planner.

Showing or hiding the Toolbar

You can display or hide the toolbar which contains the icons for the most commonly used StorX functions.

To display or hide the toolbar, on the menu bar, click on View then Show Toolbar. This is a toggle switch and will show or hide the toolbar.

Adding text to the canvas

You can add text to your management set to annotate certain devices or add some notes that pertain to the management set. Additionally, you can associate (link) the text to a specific device or box in the management set. If you associate text with an object on the canvas, whenever the object is moved, the text is moved with it.

To add text to a management set:

1. Select the Add Text icon, on the Parts Palette, and click the pointer on the canvas where you want to add text.
2. Type the text in the box that appears and press Enter.

To move text, click on the Select icon, then click and hold mouse button 1 on the text.

To associate the text with an object on the canvas, see "Associating text with an object".

Associating text with an object

When you add text or a box to a management set, you can associate (link) them to each other, or to a specific device in the management set. When you associate text with an object on the canvas, whenever the object is moved, the text is moved with it.
When you associate text with an enclosure, or the sections of an enclosure, the associated text follows these rules:

- If the text is associated with a device in an enclosure, the text moves with the enclosure, or the enclosure section that contains the device.
- If the text is associated with an enclosure section, the text will move with the enclosure section. If you join the enclosure, the text will move with the enclosure.
- If the text is associated to an enclosure, the text will only move with the enclosure.

To associate text with an object:

1. Click on the Select icon, then click the text with the right mouse button and select Associate from the pop-up menu.
2. Click on the object to associate with the text.

To remove this association see “Deleting an association” on page 56.

---

**Adding a box to the canvas**

You can use boxes to identify groups of devices, or to contain text, that are associated with the box.

To add a box to the canvas:

1. Select the Box icon and position the pointer on the canvas where you want the box placed and press and hold mouse button 1. You can now drag the mouse to create the size of box that you want to create.
2. Draw the size of the box with the mouse. You can drag the box to any location on the canvas

To move a box, click on the Select icon, then click and hold mouse button 1 in the box and move the box.

To change the size of a box, click on the Select icon. Then click and hold mouse button 1 on the corner of the box, and adjust the size of the box.

To associate the box with an object on the canvas, see "Associating a box with an object".

---

**Associating a box with an object**

You can associate the box with an object on the canvas so when the object is moved, the box is moved with it. For example, you could add a box around four disks and associate this box to any of the four disks. Then you could add a text annotation that describes the disks and associate the text to the box. If you move the associated disk in your management set, the box, and associated text annotation will move with the box.

If you did not associate the box or text with the disks, they would not be moved with the disks.
When you associate a box with an enclosure, or the sections of an enclosure, the associated box follows these rules:

- If the box is associated with a device in an enclosure, the box will move with the enclosure. If the box is associated with a device in an enclosure section, the box will move with the enclosure section that contains the device.
- If you associate the box with an enclosure section, the box will move with the enclosure section. If you join the enclosure, the box will move with the enclosure.
- If you have associated the box to an enclosure, the box will only move with the enclosure.

To associate a box with an object:
1. Click the box with the right mouse button and select Associate from the pop-up menu.
2. Click on the object to associate with the box.

To remove this association see “Deleting an association” on page 56.

---

**Specifying a default box color**

When you are using StorX, you can specify a default color for all the boxes that are added to a management set.

To specify a default color for the boxes you will add to the current management set:
1. Place the pointer next to the Box icon on the Parts Palette.
2. Click on the arrowhead symbol, or right click anywhere on the icon, to display the Box Properties window and select the box color you want.

To specify a default color for the boxes in a new management set:
1. On the menu bar, click on File, then Management Set Properties (Current).
2. Click on the Annotations tab on the Management Set Properties window.
3. Select the box color you want in the Default Box Color section of this window.

---

**Specifying a color for an individual box**

When you are using StorX, you can specify a color for each specific box in the management set.

To specify a color for a box:
1. Right click on the box, then click on Properties in the pop-up menu.
2. Select the color that you want assigned to the box from the drop down list on the Box Properties window.
Deleting an association

StorX displays a dotted line between the text or box and the associated object when you select the object on the canvas. To remove this association:

1. Right-click on the text or box whose association you want to remove.
2. Select Associate from the pop-up menu.
3. Move the mouse pointer to a blank space on the canvas and click.

For information on adding an association, see “Associating text with an object” on page 53 and “Associating a box with an object” on page 54.

Performing group operations

You can perform the several types of operations on multiple items at the same time. To do this, you need to draw a boundary around the area by using the mouse. Some of the group operations you can perform are:

- Delete several devices at the same time.
- Display the properties of multiple disks, adapters, or enclosures. You must include the same type of device in the boundary area.
- Change the color of multiple boxes at the same time.

To identify those items you want to perform group operations on, do the following:

1. Click on the Select icon, then draw a box around the devices you want to work with, using the mouse. Do not use a box annotation to draw a box around the devices.
2. StorX highlights all items within the boundary area, and you can perform the group operation on the selected items.

Deleting extra space from the canvas

When you add storage networks that do not fit on the canvas, StorX expands the canvas to hold the network. When you remove objects from the canvas, StorX does not automatically change the size of the canvas. To reduce the canvas size, you should change the size of your StorX window by dragging a corner of the main application frame window.

Automatically arranging objects on the canvas

Layout automatically arranges the objects in the storage network that are displayed on the canvas.

When you use the Planner, you can use this function to arrange the storage network while you are creating it.

When you use the Live Viewer, StorX automatically discovers and arranges the live storage networks. You can use this function to rearrange a live storage network after you have changed or deleted any unknown or missing devices.
StorX automatically performs a storage network layout when StorX discovers a new storage network. If new devices or connections are detected on subsequent discover operations, such as when you select Refresh Storage Networks, StorX does not layout the refreshed storage network.

Also, StorX does not automatically layout a storage network that contains missing devices or connections.

To have StorX automatically arrange the display of your management set, on the menu bar, click on Edit, then Layout.

You can also select Layout from a pop-up menu by right-clicking on any empty space on the canvas.

Displaying a grid on the canvas

You can display a grid, to help you align objects on the canvas. You can use Grid, or you can use Grid with the Snap function to ensure that you align with the grid.

StorX does not print grid lines when you print a management set. StorX also does not display grid lines if you select the Pan To function.

To display a grid or choose Snap, go to the menu bar, click on View, then Grid, and Snap (if desired).
Chapter 10. Creating management set reports

StorX provides the ability to import the following data into another application such as a spreadsheet or a database program.

- Hosts in your management set (Live Viewer only).
- Topology of your management set.

Note: You should always perform a full discover or refresh before creating a management set report. This will ensure that your report contains all of the data that StorX can report about your storage network.

Exporting management set report data

To export report data from a management set to create a report:

1. On the menu bar, click on File, then Report.
2. Select the report type that you want to create.
3. When the Save As window appears, type the file name of your report data. StorX will supply a default name of *.rpt.

StorX report formats

StorX enables you to create a report of host-based information or topology-based information. You can import this report data into a database or a spreadsheet. See "Importing report data to a spreadsheet—example" on page 6 for an example of how to import report data into a spreadsheet.

Host report format

If you are using the Live Viewer, you can create a report that details the devices that are connected to the hosts in your storage network. The host report provides information about the devices that are attached to the hosts in the management set. When you look at this information, you may notice that a device may appear more than once in this report. This is because the device is connected to more than one host, and is listed with each host. This report shows the current state of the management set. The device states listed reflect the devices states when StorX last updated the management set.

The sections in a host report are:

Report header
   The report header section provides general information about the management set on which the report is based.

List of hosts
   This is a list of the hosts and their attributes in the management set.

Devices associated with a host
   There is one section per device type (adapters, physical disks, enclosures, and logical disks).
Logical disks to physical disks
This is a list that shows the association between a logical disk and a physical disk.

Topology report format
The topology report provides information about the devices that make up the topology of the storage networks in the management set.

The sections in a topology report are:

Report header
The report header section provides general information about the management set on which the report is based.

List of hosts
This section provides the attributes for the hosts in the management set.

List of enclosures
This section provides the attributes for the enclosures in the management set.

Enclosure slots
This is a list of the devices that occupy the slots in each enclosure. If this information is from a Live Viewer management set, StorX lists the disks by their external label, the adapters by their host name. If this information is from a Planner management set, StorX lists the devices by their unique ID. The columns describing the enclosure slots are:

- Enclosure ID
- Slot number
- Device ID
- Device type (disk, blank, empty)

Storage network devices
This is a list of the devices and their attributes in each storage network.

Storage network connections
This is a list of the connections and their attributes in each storage network. StorX lists the connections, and their attributes in a From column and a To column. The information in the columns is:

- From ID
- From type (disk, adapter, enclosure)
- From port
- To ID
- To type (disk, adapter, enclosure)
- To port
- Connection attributes

Host to adapters
This is a list of the hosts and the adapters to which they are connected. StorX also lists the host Internet Protocol (IP) addresses, adapter names, and enclosure slots.
Importing report data to another application

You can import data from a management set to another application, such as a spreadsheet or a database program. Note the following if you are importing StorX data into another application:

- If you import StorX data into a spreadsheet, you should import the data as a text file.
- StorX creates the report data with the pipe (|) character as a delimiter.
- If there is a pipe (|) character in the StorX data, StorX will change the pipe character to a period (.).

Importing report data to a spreadsheet—example

The following is an example of how you would import management set report data into a Lotus 123 spreadsheet.

2. Start up Lotus 123 and on the Lotus menu bar, choose File, then Open.
3. When the Open window appears, change the Files of type selection to ‘Text (TXT;PRN;CSV;DAT;OUT;ASC)’.
4. Type in the path and file name of the management set report you created.
5. When the spreadsheet lists your file in the File name field, click on Open.
6. When the Text File Options window appears, click on Start a new column at each..., and select Other character(s) from the associated list.
7. The .rpt files use a pipe (|) character as a delimiter. Enter a pipe character in the box next to the Other character(s) field and click OK.
8. The report will then load into the spreadsheet and you can change the size of the columns to your viewing preferences.
Chapter 11. Printing

This section discusses the various tasks that are associated with printing the information in a management set.

When you select Print, StorX opens a dialog window so you can make choices concerning the print operation. You can choose:

- Printer name selection
- Select all, or a range of pages to print.
- Select collated, or non-collated print sequence.
- Select the number of copies to print.
- Select to begin printing or cancel printing.
- Select various properties that are associated with paper and the positioning.

Printing the canvas

You can print the contents of the canvas, which will include all storage networks in the current management set.

**Note:** StorX only supports laser, postscript, or ink jet printers.

To print the canvas, click on the Print icon on the toolbar.

You can also print the canvas, by clicking on the File menu on the menu bar, click on Print, and select Canvas.

If you have any problems when trying to print StorX output to a network printer, refer to "Network printer problems" on page 63.

Printing cable labels

StorX aids you in documenting and labeling the connections in your storage network by providing the capability of printing labels, based on your storage network. These labels will help you:

- Connect the host adapters to the enclosures so they match your storage network plan.
- Identify the source and target of the connection if there is a problem with the storage network.

You can request to print labels by choosing one of the following:

- On the menu bar, click on File, then Print, then Labels. This will print labels for every connection in the current management set.
- Right click on a connection to access the canvas pop-up menu and click on Print Selected Labels. This will print labels for the individual connection.
- Select several connections by pressing and holding the Shift key while you click on the connections for which you want to print labels. Place the mouse pointer...
over any of the highlighted connections on the canvas and right click to access the canvas pop-up menu. Click on Print Selected Labels to print cable labels for the highlighted connections.

- On the menu bar, click on Management Set, then Storage Network Navigator, and highlight a storage network. Place the mouse pointer over any of the highlighted connections on the canvas and right click to access the canvas pop-up menu. Click on Print Selected Labels to print cable labels for all of the connections in the storage network.

Depending on the number of connections in your storage network, the labels can span multiple pages. The print window will display the number of pages necessary to print labels for all of the connections.

For each connection in the plan, StorX prints two copies (one each to attach at the source and target ends of the connection). StorX prints the same information on each side of the label, so you can fold each label in the middle. This enables you to view the cabling information on each side of the folded label. StorX prints a unique number on each label. StorX prints this same number on two labels so you can identify the pair of labels that are needed for each end of the cable.

The contents of the printed labels are:

- Enclosure, location, and port number (if the connection is from or to a device in an enclosure).
- Unique ID for the device, serial number, and port number (if the connection is from or to a device which is not in an enclosure).
- Host name, adapter name, slot number, and port number (if the connection is from or to an adapter).

When you choose to print labels, StorX checks for any disks that are not in an enclosure, for example, the disk is in a Planner management set. If StorX locates a disk that is not in an enclosure, StorX will ask you if you want to continue printing labels. If you respond Yes, StorX will print all labels, except labels for backplane connections and resiliency connections, and disks that are not in an enclosure.

You should use labels with a format of two columns and 10 rows on each sheet. For example, Avery 5161, 5261, 5961, 5661, or 8161.

If you have problems when you try to print StorX output to a network printer, refer to [Network printer problems” on page 65](#).

---

### Displaying page boundaries

You can preview the page layout by displaying the page boundaries before printing the canvas. This enables you to make adjustments to avoid page splits that intersect the devices when you print the canvas.

To preview a management set, select View on the menu bar, and then select Show Page Boundaries.
Printing a large management set

If a management set is too large to fit on a single page, StorX formats and prints the management set into page segments. This is so you can reassemble the printed management set. StorX prints information in the corners of the page segments.

When you print the management set (canvas), StorX provides information on each printed page to aid you in assembling the printed management set:

- Management set name (upper left corner).
- Page x of x (upper right corner).
- Print date, time, and management set file location (lower left corner).
- Row x and Col. x (lower right corner). The row designations and the column designations describe the relationship of each printed page to other printed pages in that management set.

You can preview the page layout by displaying the page boundaries before printing the canvas. This enables you to make adjustments to avoid page splits that intersect the devices when you print the management set. To preview a management set, see "Displaying page boundaries" on page 64.

Network printer problems

If you are having trouble printing StorX output from a Windows 95, or Windows 98 system to a Windows NT 4.0 network printer, enter the following command. When you enter this command in a Windows 95 or Windows 98 MS-DOS window you will be connected to the network printer:

```
net use \hostname\printername password
```

After you enter this command, you should exit and restart the IBM StorWatch Serial Storage Expert.

If you are having trouble printing StorX output from a Windows/NT system to a Windows/NT network printer, do the following:

1. Enter the following command in an MS-DOS window:
   ```
   net use \hostname\printername user:username password
   ```
   (You may want to refer to the Windows/NT documentation for other parameters for the `net use` command.)

2. Open the Printer Properties window and click on the Scheduling tab, and select Print directly to the printer.

**Note:** Ensure that the Print Test Page option on the Printer Properties window works. Also, ensure that other applications, such as WordPad can print to the same printer.

If this procedure does not resolve your printing problem, you may want to refer to the Printer Problems section of the Windows/NT on-line help information.
Chapter 12. Handling problems

If you encounter a problem while installing or using the IBM StorWatch Serial Storage Expert, you should consult the StorX web page. This web page has the latest information about the installation and use of this program.

You should also ensure that your system meets the following conditions:

- Your machine meets the requirements that are stated in "Installation requirements" on page 9 and "Operating requirements" on page 11.
- TCP/IP under Windows 95, Windows 98, or Windows NT 4.0 is installed and active, and you can communicate with the host systems by using TCP/IP.
- You have applied the appropriate SSA PTFs that are needed to support the system you are using.

What information should I gather before reporting a problem?

Before you report a problem, you should gather the following information:

- The version of the IBM StorWatch Serial Storage Expert that you are using. You can get this information by clicking on the Help item on the menu bar and then clicking on About StorX.
- The amount of memory (RAM) installed on your system.
- The printer manufacturer, type, and model (if relevant to your problem).
- The operating system you are using.
- If you receive an error message, provide the exact wording of the message and the steps you performed before you received the message.

Handling SSA topology changes

When you make changes to your AIX system that affect your SSA topology, some of the device attributes may be incorrect or missing. To ensure that the device attributes are correct, you must run `cfgmgr` from root. After you run `cfgmgr`, you must always run `refreshstorx`.

The `refreshstorx` command resets the cache data in the SSA network agent on your system.

If you do not have the `refreshstorx` tool, access our web site at http://www.ibm.com/storage/storwatch/storx.

Performance problems

Some items that affect performance are:

- For best performance, use 256 colors.
- Display the minimum number of labels, under each canvas object, when performing canvas operations.
- Use Windows NT 4.0 for best performance. If you have a choice of using a Windows 95, Windows 98 or Windows NT 4.0 system, you should select the Windows NT 4.0 system.
• The amount of memory StorX uses increases with the number of devices that are in the management set. For example, if you added another host, and it had several devices attached to it, StorX would use more system memory.

• Check the size of the Windows swap file on your personal computer. If you are running several applications, it can become very large and use a lot of hard disk space. This could cause StorX to issue a 'low on resources' message and possibly stop running.

• Check the number of entries in the event log. If the event log has many entries, it will slow the save and load management set operations.

• If you have events occurring during a discover operation, this may prolong the time of the discover operation.

---

**Discovery problems**

Problems with SSA disk units and adapters could cause a storage network to become unresponsive.

If this happens, the discover operation may not be able to complete. If you are receiving a 'Communications failure' message in the event monitor window, this is an indication of possible hardware problems in your storage network.

If you encounter this type of problem, cancel the discover operation and record the host names associated with the communications failures. StorX will list the host name in the message in the event monitor window.

You can identify the storage networks that are associated with these failures by noting the hosts that are associated with the communications failure messages.

To correct this situation, locate the problem hardware on the storage network and take corrective action.

**Note:** The host operating system AIX error logs and host Standard SSA Diagnostics may be of some assistance.

---

**Multiple network cards in a host**

If you have a host in your storage network that contains multiple network cards, the SSA adapter has an attribute which determines what hostname should be reported back by the device driver to the StorX network agent. This attribute is usually left unset, so the default reply is the same as for the 'hostname' command.

To display the current setting of this option, type the following AIX command:

```
# lsattr -l ssa0 -E
```

(where ssa0 is the AIX name of the ssa adapter)

To set this attribute, type the following AIX command:

```
# chdev -l ssa0 -a host_address=bigben.rchxxxx.ibm.com
```

(where bigben.rchxxxx.ibm.com is the preferred hostname)

To unset this attribute, type the following AIX command:

```
# chdev -l ssa0 -a host_address=
```
Unsupported devices

There are some storage networks that StorX is unable to discover and display the network topology successfully. When this happens, StorX may display devices that do not exist, or may fail to discover all the devices in a storage network.

StorX may also have problems when displaying SSA networks with unsupported SSA topologies.

To view a list of the devices that StorX supports see “Determining the devices StorX supports” on page 39.

Problem handling commands

The following items may be useful in handling problems that are associated with this product:

- Verify that you can contact your AIX/NT host via TCP/IP. Issue the ‘ping’ command and check to determine if you receive a response from the host system.
- Determine the levels of the installed SSA AIX filesets. Issue the command: `lslpp -l | grep SSA`
- Verify that the network agent is ready to run on your AIX host system. Issue the command: `rpcinfo -t 300667`. You should receive a response similar to the following: ‘Program Version 1 ready and waiting’.
  You could also issue the command: `cat /etc/inetd.conf | grep ssalld`. You should receive the line `ssalld sunrpc_tcp tcp wait root /usr/sbin/rpc.ssalld rpc.ssalld 300667` will be shown, and it will not be commented out.
- Determine if you can activate the network daemon. Issue the following AIX command using the full path as shown: `/usr/sbin/ssanetd &`
- Determine if there are any error messages from the RPC daemon. With `root` authority, issue the following AIX command: `/usr/sbin/rpc.ssalld -S`
Note: Always use the Uninstall StorX program to remove StorX.

1. Before uninstalling StorX, ensure that the program is not in use and that you have saved your management set files.
2. Click on the Start button and point to Programs.
3. Point to the Serial Storage Expert program group and click on the Uninstall Serial Storage Expert icon.
4. When the Confirm File Deletion window appears, select Yes to remove StorX from your system.
Bibliography

SSA Publications

The SSA publications listed here provide additional information about topics described or referred to in this book.

- *IBM Enhanced SSA 4–Port Adapter, SC23-1782,* provides information for software device drivers. This book also addresses verifying that installation and configuration were successfully completed.

Redbooks

Redbooks are named for their red covers and are written by IBM professionals from all over the world. Redbooks provide installation and implementation experiences, sample code, typical scenarios, and step-by-step ‘how to’ guidelines.

- *AIX Storage Management, GG24-4484,* assists customers and systems engineers in understanding and utilizing storage management with AIX Version 4 on the RISC/6000.
- *A Practical Guide to Serial Storage Architecture for AIX, SG24-4599,* provides information to assist customers to quickly make effective use of the Serial Storage Architecture for the RS/6000.
- *Monitoring and Managing SSA Disk Subsystems, SG24-5251,* provides information to assist customers to quickly make effective use of the Serial Storage Architecture for the RS/6000.
Index

A
adapter 39  
adding 39  
finding 37  
specifying default 39  
add 53  
adapter 39  
disk 40  
association, deleting 56  
automatic refresh  
starting, stopping 23  
delete 23  
delete missing 22  
device 20  
colors 48  
device state image 20  
device states 20  
supported 39  
unsupported 69  
device properties, displaying 41  
discover storage networks 22  
discovering a management set 16  
DSI, definition 43

B
blank, definition 49  
blanks, removing 50  
box 54  
adding 54  
associating 54  
default color 55  
individual color 55

canvas 63  
printing 63  
cfgmgr 67  
clear changes 22  
colors, devices 48  
connections 40  
creating 40  
missing 22

D
default 40  
cables 40  
disks 39  
enlosures 45  
default storage network, definition 24  
definition 35  
blank 49  
default storage network 24  
detected but not discovered 48  
discovered enclosure 43  
DSI 43  
enlosure 43  
event forwarding 31  
full discover 17  
host 35  
live viewer 3  
management set 4  
MIB 31  
midpoint 41  
planner 3  
SES enclosure 43  
SNMP 31  
storage network 4  
topology discover 17

delete 23  
delete missing 22  
device 20  
colors 48  
device state image 20  
device states 20  
supported 39  
unsupported 69  
device properties, displaying 41  
discover storage networks 22  
discovering a management set 16  
DSI, definition 43

e
event forwarding, definition 31  
event forwarding, starting, stopping 33  
event monitor 18  
clear 20  
copy 19  
export 19  
find 19  
select all 19  
ext 29  
exporting 27  
event log entries 19  
image file 27  
management set 27

G
grid 57  
group operations 56

H
hide parts palette 53  
hide toolbar 53  
host  
adding 35  
definition 35  
deleting 35  
domain 17  
report format 59  
state 36  
host names, identical 28  
host state 36  
attributes modified 36  
good 36  
new, attributes modified 36  
new host 36  
suspect 36

I
icon 53  
add disk 40  
device state 20  
information area 7  
installation 9  
CD-ROM 9  
requirements 9  
web site 9  
Windows NT 10

L
labels  
printing 63  
recommendations 64  
layout 56  
license 9  
diskette 11  
requirement 9  
live viewer 3  
definition 3  
file extension 3  
logical disk 51  
associated adapters 52  
capacity 51  
description 51  
detailed information 52  
host information 37  
serial number 51  
state 51  
status 51  
synchronized 52  
type 51
M
management set 4
  box, associating 54
closing 29
copying 28
creating a planner management set 15
default properties 15
definition 4
deleting a host 35
deleting extra space 56
exporting 27
full refresh 23
grid, displaying 57
host, adding 35
merging 27
naming 15
new 15
objects, deleting 23
page boundaries, showing 64
refreshing 23
sample 3
saving 28
statistics 21
text, associating 53
topology refresh 23
menu bar 5
MB, definition 31
midpoint, definition 41
midpoint, deleting 41

N
network agent, version 36

O
operating requirements 11
operating system, determining 36

P
pan to 24
parts palette 6
performance 67
planner 3
  definition 3
  file extension 3
  management set, opening 16
  sample management sets 3
polling time, setting 18
printing 63
cable labels 63
canvas 63
enclosures 50
network problems 65
problems 65
commands 69
discovery 68
gathering information 67
handling 67
multiple network cards 68
network printer 65
performance 67
topology changes 67
unsupported devices 69

R
redbooks 73
refreshstorx 67
related publications 73
  redbooks 73
  SSA publications 73
reports 59
  creating 59
  exporting 59
  host 59
  importing, example 61
  importing data 61
topology 60
restrictions, changing enclosure types 45

S
save file 28
SES enclosure
  definition 43
  identifying 44
  working with 44
show 64
  page boundaries 64
  parts palette 53
toolbar 53
SNMP 31
  definition 31
  events 31
  traps 31
SSA publications 73
starting StorX 12
  commands 13
  file icon 12
  program icon 12
storage network 4
cancelling discover 16
default 24
definition 4
deleting 26
discover 22
discovering 16
finding logical disks 51
hiding 26
host, adapter 26
renaming 27
report 60
showing 26
state 27
Storage Network Navigator 24
storage network states 24
  attention 25
  broken 25
  changed 25
  degraded 25
  exposed 25
  good 25
  missing 25
  new 25
  unknown 25
StorX 1
display 5
installing 9
overview 2
support 7

T
text 53
  associating 53
toolbar 5
toolbar functions 18
  delete 23
  event monitor 18
  pan to 24
  print canvas 63
  save 28
topology changes 67
topology refresh, starting 23

U
uninstalling StorX 71

V
view menu 24
  grid 57
  pan to 24
  show enclosures 46
  show page boundaries 46
  show parts palette 53
  show toolbar 53

W
web site 7